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Umbrella Documentation

https://docs.umbrella.com/deployment-umbrella/docs/welcome-to-cisco-umbrella

Basic Level Filtering

The most basic implementation of the Cisco Umbrella filter will afford you the state’s default filtering level for
all your users. Simple and quick to implement, this level of filtering makes no distinction between your users
and is not Active Directory aware. All it requires is a change to the DNS forwarders on your local DNS

server(s).

OpenDNS Forwarders

Add the OpenDNS Forwarders to ALL of your DNS servers. The OpenDNS Forwarders are
208.67.222.222, 208.67.220.220, 208.67.220.222, and 208.67.222.220

1. Open DNS Manger or type DNSMGMT from run or CMD prompt

= Administrator: Command Prompt

icrosoft Windows [Uersion 6.3.966081
(c> 2013 Microsoft Corporation. All rights reserved.

\Users\fdministrator>dnsmgmnt

2. Select your server name, right click the server name and click Properties
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https://docs.umbrella.com/deployment-umbrella/docs/welcome-to-cisco-umbrella

3.

File | Action View Help.

e sERXBa=HmE 8

£ DNs '
4 i ZO‘IZDC‘II

p | Forward Lookup Zones
b | Reverse Lookup Zones
p | Trust Points
p | Conditional Forwarders
b (] Global Logs

Name

| Forward Lookup Zones
| Reverse Lookup Zones

1 Trust Points

[ Conditional Forwarders
£2]) Global Logs

E._Ej Root Hints

| Forwarders

In your DNS Server Properties, select the Forwarders tab

4. Uncheck the use root hints box and then click Edit
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Debug Logging
Intedfaces

Forwarders are DNS servers that this server can use to resolve DNS
queries for records that this server cannot resolve.

IP Address Server FQDN
170.94.156.195 resolver] state arus
170.94.156.196 resolver? state ar.us

;]Lbemm:imfwadersmavalable
Not

e: If conditional forwarders are defined for a given domain, they
used instead of serverdevel forwarders. To create or view i
forwarders, navigate to the Conditional Forwarders node in the scope tree.

o e [~ | )

5. Delete ALL existing DNS Forwarders, add 208.67.222.222, 208.67.220.220,
208.67.220.222, and 208.67.222.220 as your new forwarders
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Edit Forwarders *

IP addresses of forwarding servers:

IP Address Server FQDN Validated Delete
an IP Address or DNS Name =

'iﬂ' 208.67.222,.222 resolver 1.opendns.com OK L
i@' 208.67.220.220 resolver 2.opendns. com 0K

i@' 208.67.222,.220 resolver 3.opendns. com oK Down
'Z@' 203.67.220.222 resolver4.opendns.com 0K

Mumber of seconds before forward gueries time out: | 3

The server FQDM will not be available if the appropriate reverse lookup zones and entries are not

configured.
Cancel

6. Click OK > OK > Close your DNS Manager

7. Do this on every server that has DNS installed

Local IP Level Filtering

A second level of OpenDNS implementation requires installation of multiple virtual appliances on
virtual hosts within your network. Best Practices call for installing at least two appliances on two separate
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physical hosts for redundancy and fault protection. These appliances allow for more detailed reporting, and
custom filtering.

Virtual Appliance Requirements
Virtual Appliances (VAs) are needed for detailed reporting and identity information, Active Directory
Integration, and granular Policy Management. Listed below are the requirements needed for the VAs to work.

1. 2 VAs per Site — In order for automatic updates to occur without downtime and for redundancies
sake at the DNS level, you must have two VAs per site, each on separate Hypervisor servers.

2. VA Specs — Each VA requires the following resources:

a. 1 Virtual CPU

b. 1024 MB of RAM Recommended (minimum 512MB)

c. 7GB of disk space
NOTE: The above resources allow each VA to process millions of DNS requests per day. It is
estimated that 1 VA with the above mentioned amount of resources can serve over 100,000
endpoints.

3. Correct Date/Time — The incorrect date or time can cause update or sync issues with the VAs.
Ensure your Hypervisor host has the correct date and time. The VA syncs time independently and
is always set to UTC.

4. VMWare or Hyper-V — The VAs can run either on VMware or Hyper-V

a.  VMware requires ESX or ESXi 4.1 update 2 (or newer)
b. Hyper-V requires one of the following Windows Server Operating Systems:
i.  Windows Server 2012, SP1, or R2 (Standard or Datacenter), 2016, or 2019
with Hyper-V role
ii. Hyper-V Server 2012, 2012 R2, 2016, or 2019

VA Networking Requirements

Once VAs are deployed and ready to be utilized, endpoint clients must exclusively resolve DNS through the
VAs and not your local DNS forwarders. This is usually accomplished through the network's DHCP
configuration. The following firewall/ACL requirements ensure VAs can communicate with the Umbrella cloud
services and local DNS forwarders/servers.

Port and Source Destination Note

Protocol

53 TCP + Virtual Appliance | Local DNS servers Standard DNS traffic for internal domains.
UDP
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53 TCP + Virtual Appliance | Umbrella resolvers Standard and encrypted DNS queries to Umbrella resolvers.
UDP Default: Port 443 is used as failover if your firewall does not allow
e 208.67.220.220/32
443 TCP DNSCrypt t 53.
3TCP+ o 208.67.222.222/32 SCrypt on port >3
DP Port i fail if DNSCrypt is not all t
U If you have configured the VA to ort 5353 is used as failover i SCrypt is not allowed on port 53
TCP t 443.
5353 * use other Umbrella resolvers: and port 443
UDP
Alternate:
e 208.67.220.222/32
e 208.67.222.220/32
IPv6:
o 2620:119:35::35
e 2620:119:53::53
US-only:
e 208.67.221.76/32
o 208.67.223.76/32
US-only IPv6:
e 2620:119:17::76
e 2620:119:76::76
443 TCP Virtual Appliance : ?g;;ﬂ%nggszi%m HTTPS—Used for registration, health checks, and updates from
o 146.112.255.152/29) Umbrella.
* ocsp.d_lglcert.com ocsp.digicert.com and crl4.digicert.com use a CDN and are not
e crl4.digicert.com
e cisco.com assigned static IP addresses, thus are subject to change.
Currently, these domains resolve to the following IPs:
e 72.2191.29
e 117.18.237.29
e 03.184.220.29
e 205.234.175.175
80 TCP Virtual Appliance ° OCSp'qlqlcert'Com HTTP—Used for fetching the SSL revocation list to initiate the
e crl4.digicert.com
HTTPS connection.
443 TCP Virtual Appliance | disthost.umbrella.com Updates to the VA
Port and Source Destination Note
Protocol
22 Virtual Appliance | s.tunnels.ironport.com Required for the customer-initiated SSH support tunnel. For
255380443 more information, see On-Demand Tech Support SSH Tunnel for
or 4766 TCP Virtual Appliances.
123 UDP Virtual Appliance | NTP servers NTP—Protocol to synchronize time.

Default:
e ntp.ubuntu.com
o (91.189.94.4/32
e 91.189.89.199/32
e 91.189.91.157/32
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https://support.umbrella.com/hc/en-us/articles/115004154423-On-Demand-Support-Tunnel-for-the-VAs
https://support.umbrella.com/hc/en-us/articles/115004154423-On-Demand-Support-Tunnel-for-the-VAs

e 91.189.89.198/32)
If you have configured custom
NTP servers on the VA, use those

IPs instead.

443 TCP Chromebook Virtual Appliance(s) Required for Chromebook client trusted network feature.
client

443 TCP Umbrella AD Virtual Appliance(s) Used to send user/IP mapping (one-way) from the Active
Connector Directory (AD) connector to the VA.

Download Virtual Appliance:

1. Create a folder called openDns to download the necessary files to.
2. Navigate to Unmbrella.com and login. Then navigate to Deployments > Sites and Active
Directory (under Configuration).

3. At the top of the screen click “ Download Components”
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https://docs.umbrella.com/deployment-umbrella/docs/trusted-network-detection
https://docs.umbrella.com/deployment-umbrella/docs/appx-a-communication-flow-and-troubleshooting
https://docs.umbrella.com/deployment-umbrella/docs/appx-a-communication-flow-and-troubleshooting

4. Depending on whether you’re using VMWare or Hyper-V, download the appropriate “VA for”

Download Components

Interested in learning more about our available downloads? Visit Umbrelia Docs

Active Directory Components

Windows Configuration script for Domain Conuolier DOWNLOAD

Windows Service (Active Directory Connector) DOWNLOAD

Virtual Appliance Components

Use as the default password for this VA

VA for VMWare ESXi DOWNLOAD

VA for Hyper-V DOWNLOAD

CANCEL

5. If you plan to integrate Active Directory to your system, Download the Windows
Configuration script and Windows Service (see Configure Active Directory)

Each new school must download their own files from their Umbrella Portal as the files are tagged to
that school when downloaded.

Hyper-V Virtual Appliance Deployment
To deploy the VA in Hyper-V for Windows Server it is best to create a new VM and attach the
Hard Disk after the fact. For Server 2012 R2 it is mandatory.

1. Select your Hyper-V Server Name on the left and then select New > Virtual Machine in the
Actions menu along the right side of Hyper-V Manager
Click Next on the Before You Begin page if you get that
Name the VA with the format SCHOOL-VA followed by the number for the VA.
a. If this is your first VA then the name should be YOURSCHOOL-VAL.
b. Check the Store the virtual machine in a different location
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c. Navigate to the location where VM’s are stored on this network

e New Vitusd Machoe Wizard X {
-}k‘ Specily Name and Location
Sefore You Begn Choose & neme and ocation for thes vrtusl machne

s
Specty Name and Location The rame is deplayed n Hyper 4 Marager, We recommend that you use 8 name that helps you sesly

Speafy Generation dendify the virtusl machine, such as the name of the guest nperstng system or workiond
Assagn Memory e SCHOOL-YAL

Configure Netaarong You can create a folder or use an existing folder to store the wrtual machine, If you don't select a

Cornect Vartual Hard Dk folder, T virkual machine s stored I the default falder configured for this server

Instalaton Opbons 7] Store the vetusl mactine 1 different location

Susmary Locaton: (T Bo

£ ¥ you plan o take checkponts of thes vrtual machioe, select 3 iocation that has eough free
soace. Chedponts ndude virtun machine data and may require a lrge amount of space

4. Click Next
Make sure Generation 1 is selected. The VA’s are built using this format. Click Next
Assign 1024MB of RAM to the VM. As mentioned in the VA Requirements section, 512
MB is estimated to serve 100,000 endpoints a day. Click Next
Select your Network Adapter and click Next
Select the option at the bottom: Attach a virtual hard disk later and click Next
Click Finish

Now we need to copy the .VHD files you downloaded in the Prerequisite section to the newly
created VM location and configure the VM Settings.

1. Find the file you downloaded all of your Prerequisite files to. Find a .zip file named
OpenDNSVirtualMachine-20151203 and extract it.
Open the newly extracted file and Copy the Virtual Hard Disks folder.
Navigate to the folder containing the VM on the Hyper-V Server (The location assigned in
step 3 of the previous section.)

4. Paste the Virtual Hard Disks folder into the folder named after the VM you created.
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5. Go into the Virtual Hard Disks folder and rename the two .VHD files to dynamic-va-1

and forwarderva-1 (change the 1 to a 2 if this is your second VA)
| [F || = | SCHOOL-VA1 v

- o i
Home Share View

Fhe : v
f & Moveto~ X Delete ~ e @ 5 B setect an
8 B b4 (A a7 Select none
Pinto Quick Copy Paste [l Copyto~ =0 Rename New Properties ;
access E] Py folder - DD Invert selection
Clipboard Organize Neaw Open Select
&« s « HV » SCHOOL-VA1 v O Search SCHOOL-VA1 pel
SRSy A
[&] Pictures * & Name Date modified Type
i Virtual Hard Disks 12/7/2016 2:33 PM File folder
Pictures

Virtual Machines 12/7/2016 1:52 PM File folder
Virtual Hard Disk

Virtual Hard Disk
¢@ OneDrive

[ This PC
B Desktop

|5 Documents
v <
Bon o

2items  1item selected  State: 3} Shared

Go back to your Hyper-V Manager

Right Click the VM that you created and go to Settings
Select IDE Controller 0

Make sure Hard Drive is selected on the right hand side and click Add

© o N o

{2 Setiings for SCHOOL-YAT on DIS-SHELBYSERY

= X
SCHOOL-VAT v 4 G
8 Mardwacs B0 D Contraer
W Add Hadware
& a5 Yous can 2dd hurd dves and CO/OVD drives to your IDE contoler.
Beot fion) € Select the type of drive you ment 1 stach t0 the controfier 3nd then chck A,
W Simary
o DVD Drive
4 [@ Pracessor |
rnn e 16
= i IDE Controder 1 4 Hard Drive
L v Orme aod
You can change how this viriual hard dckic attached th the virtusl machne. [ an
B SC51 Cantroler You can configure & hard drive to use 8 vitual harddsk o & ohyscal hard disk after operatng system is nstaled on tis dsk, dhanging the attachment might prevent the
e Tou ttach the drive to the controer, ViUl madne from startng.
# | Netwoec Adspter
A% Intiems Contrefier: Locaton
oM IDE Controler 0 v O(ouse) v
7 com2 Heds

You can compact, convert, expand, merge, reconnect o shrnk & virtual hard dsk
T Dkatae D by sdting the accocisted Se. Spacfy the Al path ts the file
4 Memagement

@ virtwol hard dok:
1) tame

|
2= Integraton Servces

t Browse...
W] Crmciponte

&4 Snart Pagey Fle Locaton
D Actomate Sart acten

) 1F the physial hard dsk you vant to use S not ksted, make sure that the
disk is offfine. Use Disk Management on the physical computer to manags

g physical hord disks,

= Automatic Stop Action

To remove the virtusl hard dizk, dick Remove, This disconnects the dsk but does not

delete the sssccated fis,
=

Remove

10. Click Browse and navigate to the location of the hard drives you just copied above
11. Select forwarder-va-1 (or -2) and click Open
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12. Repeat steps 8-10 for the dynamic-va-1

13. Click Apply and OK

'{_‘ Settings for SCHOOL-VAT cn DIS-SHELBYSERV o vt X
IscHooL-vAl vl 4 r G
2 Hardware ~ & Hard Orive:
¥ Add Hardware
N BI0S Ywmmmhmmﬂsawwmemm Ifan
T o6 €D operatng system is instalied on this disk, changing the attachment might prevent the
¥, iy virtal machine frem starting.
Contraller: Lecaton:
10 Controller 0 v | 1muse) v
e
Cl Mc"""“”‘o Tou can compact, convert, expand, merge, reconnect or shrinka vrtual hard disk
# (s Hard Drive by editing the associated fie. Speafymeupahmﬁn
forwarder-va-1.vhd @ Virtual hard disk:
#* (s Hard Drive
Gyneimic-va:Lvkd C:HVISCHOOL-VA1\\ir sl Hard Disks \dynamsc-va-1. vhd |
& 8 102 Contoller 1 |
New Edit Inspect | Srowse... |
€ Do
B2 SCsi Controler
® § N:twurkkdema
¥ 1fthe physical hard dsk you want to use is notlisted, make sire that the
'?cou: dick i offine. Use Disk Management on the physical computer to manage
physical hard disks.
cmz
b T the | hard dik, chck the disk but does not
delete the assodeted file.
[,j Mneonve
Remove
2 Mamgcmenl
1L ane

NOTE: forwarder-va-1 must be the first drive (location 0)!!

VMWare Virtual Appliance Deployment

1. Log into your VMware vSphere client and
select the 'File" tab.

2. Click Deploy OVF Template, choosing the
.OVA template downloaded from the Umbrella
dashboard.

3. Follow the deployment wizard prompts, but be sure to follow these key steps:
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-For the source, browse to the .ova file you downloaded during the Prerequisite
section. -Specify a unique name and location of your Virtual Appliance

Name and Location
\ Specfy a name and iocation for the deployed template

Source Name:
QVF Terpiate Detals
iy preer [Your Network's|OpenDNS Virtual Appiance
Storage The name can contan up 1o 80 characters and it must be unique within the inventory folder,
Drsk Format
MM -" Ag Inventory Locabon: =

Disk Format |
1n which format do you want to store the il deks?

Sarce Datastore:

PisSc
faaree and Aacabon Avalable space (GB): [—ng"'

Disk Format
Peatwork Magpng

Ready 16 Complete T Lary 2 g

5. Next, select or map a network:

OVF Template Detads Map the networks used in this OVF tempiste to networks in your inventory

Thin Provision.

Network Mapping

6. Click Finish.

The systems will begin deploying the Virtual Appliance and subsequent prompts will update you regarding
the status.

16|Page


https://files.readme.io/ENgu5RL5R0qxWow8Vn5f_name_and_location.png

Configure the Virtual Appliances
It’s time to configure the VAs. You will need the following information.

. Right Click the VM and click Connect
2. At the top of the new window select the Green Power Button
3. Letthe VM load until you see the following image (If you have DHCP it will
automatically obtain an IP, my example does not)

SYstem

Forwarder Status
Mame :

MAC: 00:15:5d:5

Connectivity

This DNE Serwver: DNE ok .

Lo - s | igured
s incompled

0 domains

version:  2.4.4

4. Press Ctrl+B to enter Config Mode

after you sign in.
g he Umbrell

(M

5. You will find your Org ID in the URL of your Umbrella Dashboard. In the example below the

OrgIDis 2385312

< & & https://dashboard.umbrella.com
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6. Enter the default password, in this example | will use Umbrella2385312 (you won’t see any text when typing
the passwords)

7. Once logged in, you will be prompted to change the password. First you will enter the default password
again. Umbrella2385312

#*

You have 1 1 in with the default jord.
er the default password at the prompt of ©(current) UMIY

the following criteria:
.
LOne upper : letter and an integer.

""" in ord only if your keuboard layout is "EnglishiUnited

rd immediately (root enfor

10. Finally you will be at the config mode prompt.

nt an M 4. Use the 'config' command for any configuration changes.
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12. After you press enter you will see it sets the name.

chool-YAl

13. To set the IP address type: config va interface <IP address> <Subnet> <Gateway> then press enter

% config va interface 192.168.88.11 255.255.255.0 192.1/58.858.2_

14. After you press enter you will see it sets the IP info.

15. To set the local DNS servers (most commonly your DC’s) type config localdns add <dns1> then press enter,
type config localdns add <dns2> then press enter. Each DNS server has to be added with the command
individually.

fig localdns add 192,158,283, 10

Localdns Serw

Localdns Sery

17. That completes the config process, type exit to exit the config mode
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18. You will now see that your VA is fully configured.

Forwarder Status
Wame: School-Wail

MAC: 00

19 domains

Version: 2.4.4

NOTE: If Support Tunnel: SSH is red and says failed, it may take a little longer for it to make a
connection. It won’t hurt anything

if it doesn’t at all. This tunnel is for OpenDNS techs to be able to remote into your VA to assist you
if you request it.

It is also normal to see the “AD Connector: Unknown” message, as the optional Active Directory
integration has not been configured as of yet.

Repeat Steps for the second VA

Repeat the above steps to configure a second VA. A second VA is required for continuous operation, high

availability, and automatic upgrades. Do not clone the first VA. Umbrella will not recognize a cloned VA.

Warning

Umbrella VAs cannot be cloned. Ensure that your second VA is set up manually. Umbrella will not recognize a
cloned VA.
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Local IP and Active Directory Filtering

Finally, OpenDNS can be fully linked to your Active Directory structure. This option provides you with the
most detail in reporting and identity.

Prerequisites

e Windows Server 2012, 2012 R2, 2016 or 2019 with the latest service packs and 100MB free hard disk
drive space. Service packs prior to SP2 are not supported.

e _.NET Framework 4.5, or 4.7.
.NET Framework 3.5 should not be running on the same system. If .NET Framework 3.5 is required,
confirm that all Windows patches on this server are applied.

e If alocal anti-virus application is running, allow list the OpenDNSAuditClient.exe and
OpenDNSAuditService.exe processes.

Create AD User:

If you are going to use the AD connector then a user needs to be created and assigned to specific groups for the
connector to access AD.

1. Open Active Directory Users and Computers and Navigate to YourDomain.local > Users

2. Right Click > New > User

3. Make the User logon name: OpenDNS_Connector

4. When creating the password, do not use a backslash or quotation marks.

New Oiject - User =T New Object - User -[
3 Cmmers  achodlocsl/Uses !) Caaler  sohodl local/Users
“wh H
Frst naoe Cipany Vet i 7‘ P ageword seanannan ]
Lagt nama ONS Corbim password fesssssves I
2l sccalasics | Deer must changs password of, et logon
Lsey iapass farhe User clrrdl crunge passwesd
10penDNS_Conracner Sscheollvcy v v Pastmird never mpasy

Loer inpan name gue Windoss 2000) ACTOUrt it Ssatied

T SCHOOL! OpanNS Corvactor

{

e S T e e TSP e

fext > oot  cBak [ meur>

Once the user 1s created, add the user to the following

Rerrctocortrd | Famcte Duskiop Seviions Frofie COMe l

groups by right clicking the user > Properties > LA oot I“"‘:Ml_z"""j | '—::;:” i
Member Of tab > Add - i
: -

a. Event Log Readers g kctr08, Comccey [iomans Savions Fokoes 3

b. Distributed COM Users Demsalioms | ieheiossithen !

c. Enterprise Read-only Domain Controllers R R 4
Click Apply and OK ,l
|

NOTE: Make the user exactly like the picture. :

4

eyt Astwve ‘

b|
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DCOM Permissions

Even though we have added the new user to the correct member groups in AD, we need to manually add the
OpenDNS_Connector user permissions. This may seem redundant but sometimes, even though the user is part
of the groups, they don’t always get the permissions needed. Let’s start with the DCOM permissions.

1. Open a CMD Prompt and type DCOMCNFG

104 Administrator: Command Prompt
icrosoft Windows [Uersion 6.3.96001
(c> 2013 Microsoft Corporation. All rights reserved.

:\Users\Administrator>DCOMCNFG_

1. When the new window opens, expand Component Services and click on Computers.
Right Click on My Computer and select Properties

P

%. File Action View Window Help

"?'::—‘-' =2 ¥ B x | Q) | m o

>
-

#. Compenent Services
| Computers

§3] Event Viewer (Local)

Services (Local)

'

2. In the new properties windows, click the COM Security tab
My Comput‘emes IL—

Defaul Protocls | COMSecuty | MSDTC |
General ‘ Options | Default Properties |
By Name: 2012DC1
Description:
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3. Under the Launch and Activation Permissions section, click on Edit Limits...

My Computer Properties ? X
General Options Default Properties
Defautt Protocols COM Security MSDTC

Access Pemissions

You may edit who is allowed default access to applications. You may
also set limits on applications that determine their own permissions.

Caution: Modfying access permissions can affect the ability
| of applications to start, connect, function and/or run
S securely

| Edtumts. | | EdtDefaut. |

Launch and Activation Pemmissions

You may edit who is allowed by defautt to launch applications or
activate objects. You may also set limits-on applications that

detemine their own permissions.
Caution: Modifying la d activation pemissions can
1 affect the ability of apj ons to start, connect, function
* and/or run securely™

[ Edtlmes. | | EdtDefauk. |

4. Select Add.. then type in OpenDNS_Connector in the box and click Check Names and
OK

Select this object type:

|Users. Groups. or Builtin security principals | I Object Types... |
From this location:
[dstrictocal | [ Locations... |

Enter the object names to select (examples):

(OpenDNS_Connector] Check Names

5. Select the OpenDNS_Connector user and put a check mark in all four boxes below.

Security Limits
Group or user names:
82, Administrators {DISTRICT\Administrators) Al
«% Performance Log Users (DISTRICT\Performance Log User
2 Distributed COM Users (DISTRICT\Distributed COM
2 Open DNS (OpenDNS_Connector@district local)
<[ [ | >
] Add l | Remove I
Pemissions for Open DNS Allow Deny
Local Launch %] 0
Remote Launch vl O
Local Activation 1) [
Remote Activation il O
ok || concel |-

6. Click OK > OK > Close the Component Services window.
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7. Restart the machine.

WMI Permissions

1. Open a CMD Prompt and type WMIMGMT and press Enter
oo} Administrator; Command Prompt

icrosoft Windows [Uersion 6.3.960801
iC(c)> 2013 Microsoft Corporation. All r»rights reserved.

\Users\Administrator>WMIMGMT _

2. When the WmiMgmt window opens, right click on WMI Control (Local) and select
Properties

=1 WmiMagmt - [Console Root\WMI Control (Local)]
E File Action View Favorites Window Help

‘V;An
e H =
T__] ConsoieT(cot ‘ B
ﬂﬁ WMI Control (Local) [0] Windows Management Instrumentation (WMI)

Configures and controls the Windows Management Instrumentation
(WMI) service.

3. Select the Security tab, expand Root, highlight CIMV?2, then click the Security button at the
bottom on the window
WMI Control (Local) Properties m

General : Backup/Restore .7590'-5"1)’7 | Advanced |

Namespace navigation allows you to set namespace specific securty.
=i Root A
+-| 41 AccessLogsin
+ & Cli
4|3 DEFAULT
+-| 41 directory
+-| 41 Hardware =
4. 7 Interop
H- 41 Inventorylogging
WMI Co ocal) Properties l ? #-L g1 Microsoft
+--[ 11 MicrosoftActiveDirectory
o == +--| 41 MicrosoftDfs
General | Backup/Rest S Ad ed T
ackup/Re: ore[ ecuntyl vanced | 41-(3) MicrosoftDNS
+-[ 01 msdtc
7| This dialog allows you to get general information about the {1 nap

’3}& computer. +1-{ 41 Policy

#1144 RSOP 2
) ) Security

Successfully Connected to: <local computer> i=h

Processor : Intel(R) Xeon{R) CPU E5620 @ 2.40GHz OK ' | Cancel ]

Operating System : Microsoft Windows Server 2012 R2 Standard
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4. Verify that the Security for ROOT\CIMV2 -
OpenDNS_Connector user is ' |

DpenD! . ooy |
listed with the following ;
L. Group or user names:
permissions. _&’!‘Mhemicated Users
Enable Account: Allow %?)LOCAL SERVICE
H2 NETWORK SERVICE
Remote Enable: Allow F ¥ Open DNS {OpenDNS_Connector@district local)
Read Securlty. A”OW Sf,Administrators (DISTRICT \Administrators)
L. . . [ Add... l I Remove l
If it is not, then add it with these
permiSSionS. Pemissions f%r Open DNS Jlﬁ\Low Dl_sen)' -
Provider Write [] [
Enable Account |
Remote Enable [v] | =
5. Click OK > OK > Close the Read Securty g
. - Edit Security [ g
WmiMgmt window.
F ial issi d d settings,
cltijélfﬁaan?e?lwons or advanced settings

Active Directory Integration
Confiqure DNS

It’s time to prepare your network for Active Directory Integration. You will want to create PTR and
A records for your VAs on your DNS servers.

Open your Server Manager on your Primary DNS server

Click Tools > DNS

Expand your server name > Forward Lookup Zones

Right Click your domain and select New Host (A or AAAA)

In the first box put the name of the VA that you used when you configured it.
In the IP Address: box put the IP used during the configuration.

Make sure Create associated pointer (PTR) record is checked
Click OK.

o N o o~ wDh e
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9. Repeat steps 4-8 to add your second VA.

File Action View Help

4= = = XKE @ = | B EE
i DNS Name “ Type Data
4 7 WINSERV-2012R2 ] (same as parent folder) Start of Authority (SOA)  [217], winserv-20
4 Forward Lookup Zones || & (same as parent folder) Name Server (NS) winserv-2012r2.s
b [ _msdes.schoollocal || £ (came as parent folder) Host (A) 10.10.0.2
p = school.local ) sinsdes
B Reverse Lookup Zones —sites
p || TrustPoints _tcp
p .| Conditional Forwarders || V—udp
> &1 Global Logs X
big Glabaltog | DomainDnsZones
EnrectDnsZones
New Host E Host (4) 10.10.0.4
Host (A) 10.10.0.5
Name {uses parent domain name if blank): Host (4) 10.10.3.0
| SCHOOL-VA-1 l Host (A) 10.10.0.2
Host (A) 10.10.0.3

Fully qualified domain name (FQDN):
| SCHOOL-VA-1.school.local, ‘

IP address:
|10.1o.0.1o| ‘

[] Create associated pointer (PTR) record

[ ] Allow any authenticated user to update DNS records with the
Same owner name

Add Host H Cancel

Do an nslookup in Command Prompt using the IP of the VA followed by another using the NAME
of the VA to test that the records are created correctly and functioning.
| - | O m

Administrator: Command Prompt

icrosoft Windows [Uersion 6.3.96881]

(c> 2013 Microsoft Corporation. All rights reserved.

:\Users\Administrator>nslookup 10.18.6.108
erver: odns—va—1.school.local
ddress: 10.18.8.4

school-va—1.school.local
16.16.8.108

:\Users\Administrator>nslookup school-va-1
erver: odns-—va—1.school.local
ddress: 10.10.8.4

on—authoritative answer:

ame : school-va—1.school.local
ddress: 10.10.8.10

:\Users\Administrator>
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Configure Active Directory

Now we need to configure Active Directory to prepare it for the Connector. In order to do so we
need to run a script that you downloaded during the Prerequisite portion of this guide. Make sure
your openDns folder that you downloaded all of your prerequisite files to, is in the Downloads
folder or a folder easy to navigate to. For this guide we will use the Downloads folder.

1. Open an ADMIN CMD Prompt on your server and navigate to your openDns folder
inside your Downloads folder. (CMD: cd Downloads/openDns)

2. Type: cscript OpenDNS-WindowsCon and press the Tab button to auto fill the rest of the
name or manually complete the name and press Enter.

Administrator: Command Prompt

icrosoft Windows [Uersion 6.3.960601]
(c)> 2013 Microsoft Corporation. All rights reserved.

:\Users\Administrator>cd Downloads/openDns

:\Users\Admninistrator\Downloads\openDns>cscript OpenDNS—-UWindowsConf igurationScyr
ipt—201308627.usf

3. The script will display your current configuration, then offer to auto-configure the Domain
Controller.
Press Y and Enter.

HE~WindowsCont igurat tonScripl

giFat don, N1l pilghts rezeraed.

antroller €y o 0237 g
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4. Copy the script to each one of your DCs and repeat steps 1-3 to fully prepare your AD
environment for the connector.
5. Verify your AD Server shows up in the OpenDns Dashboard.

Connect Active Directory

The next step is to install the Active Directory Connector now that the VAs have been installed and
the Script has been ran on ALL of your DCs. You will need the password to the
OpenDNS_Connector user that you configured at the beginning of this guide. You only need one
connector per site.

1. Open the openDns folder that houses all of your Prerequisite files. Find the .zip file
OpenDNS-WindowsService-20160128.zip and extract it.
Once extracted, open the folder and run the setup.msi
When prompted, enter the password you used to configure the user OpenDNS_Connector
in the Prerequisite section of this book.
Follow the setup wizard prompts and click Close when finished.
Verify that the server name you installed the connector on shows up in the OpenDns
Dashboard (Settings > Sites and Active Directory) and that in the Type Column it shows
AD Connector next to it.

NOTE: You can verify that the integration is complete by verifying that the jellies in the status
column of Sites and Active Directory in the Dashboard are showing green in all boxes, especially
the AD Connector box and the AD Server Box. It may take a few minutes for them to turn green
and the import to show results. Once they are green you can verify further by going to Policies >
Policy List and creating a new Policy and confirming that your groups are present.

Setup DHCP

Now that you have your VAs installed and configured, your AD is integrated into the Umbrella
Dashboard, and your Policies List is setup the last thing you need to do is configure your DHCP to
handout your new VAs as the DNS servers for your network.

1. Onyour DHCP Server open Server Manager > Tools > DHCP
2. Expand your Server Name > IPv4

2 DHCP
File. Action View Help

e @ = HFE L
Q} DHCP ‘ Contents of DHCP Status
b @ winserv-2012r2.school.local 3 winserv-2012r2.school.local
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3. Left Click on Server Options in order to get the right click menu to be available. 4. Right Click
Server Options and select Configure Options

3

File Action View Help

e 7@ & BE &

& DHCP
4 a winserv-2012r2.school.local @ Server Options
4 G IPva
7 Sc 10.10.0.0] 10.10
b :j Seoie' LM;"MOI Server options are additional configuration paran
LE % 4 or example, some commonly used optio
Q:J Po Vconf,'?,""e OPtnons... _irvers, and DNS servers.
b F Filt View > )
b i 1Pv6 ~ |ptions act as defaults for all scopes. You
Refresh on in Scope Options.
| Help ne server options, on the Action menu, cl

For more information about server options, see o

5. Puta check in the box next to 006 DNS Servers
NOTE: If there is already a Check Box here just delete and servers already listed.
6. Either put the name of the VA in the Server Name: box and click resolve or enter the IP
Address in the box below it and click Add.
7. Repeat Step 6 for your second VA.

General lAdvanced

Available Options

[J 004 Time Server
[J 005 Name Servers
006 DNS Servers
[J 007 Log Servers
<]

Fesolve

Bown

8. Click Apply and Ok
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NOTE: Depending on your lease time, after updating the DNS Servers in the DHCP options, wait
for DHCP leases on the endpoints to expire and see the new changes. In most cases, DHCP lease
durations are 7 days or less, but sometimes may be set to higher values.

Final Configuration

Confiqure Internal Network

Internal Networks allows to you manage your Umbrella policy for subnets of computers based on
the internal IP addresses of your network.

After an Umbrella Virtual Appliance (VA) has been deployed, an Internal Networks identity can be
configured. To set this up, drop one of our lightweight VAs into your network, direct your DNS
traffic through it, and start mapping your network based on specific internal IP addresses and/or
subnets.

The purpose of the Internal Networks identity is to define a subnet that's non-routable (or RFC1918
compliant) as an identity you can apply policy to. To create an Internal Networks identity, define a
subnet that's non-routable (or RFC 1918 compliant) as an identity you can apply policy to. For
example, if your Internal Network is defined as 192.168.0/24, any computer, tablet or device with
an IP on that subnet would receive the filtering policy defined for it whenever it made a request to
access the Internet.

From there you can begin to build multiples sites if you have more than one physical location or if
you have more than one Internal Network to configure.

The Umbrella VA will have your DNS traffic pointed to it for this configuration and anything
identified as coming from the networks you've defined will have the policies applied.

30|Page



1. Navigate to Deployments > Configuration > Internal Networks and click Add.

nmie bEpinymens.{ 2onta
© i |Hh—“||'d| l :

Search Intemal Networks... | a |

Primary Policy

Camera Network 9 Defaule Site T0.112:108.0/24 | Defauk Pobcy

High School Campus . 9 Diefaul: Site . 10112160 0020 .-.'

HS-COculus-02 . @ Defaul: Sire .10.112.165.511

HE0culus03 @ Defaul Sie .1c-_‘.12.1aa.|ss ]

JR-High-OculusSysem 9 Default Site .10.112.161.1D|

Judsonia Elem Campus 9 Detaul: Site 10312144022 . Letau [ ]

Kenseft Elem Campus 9 Defaule Site: 1021160022 .- it Chstrict Pok_ (@
ntemal Networks |

Oculu Q Defaul: Sie 1011220512, | Technolo

2. You'll be asked to name your network and provide a valid subnet. In this case we 've plcked
a /24 subnet, so the final octet of the IP will be .0

Deploymeants [ Conmigurs
e alualn (@)

cisco Imternal Networku =
Search Internal Networks. .. qQ

Network Name IP Address

| Elem-Private| x | | 1044550 | 2305121P81 =7 |

Site

| Detauit Site [ |

cavcaL =3

3. Click Save.

Note: If you are unable to save your changes, it may be because the Cisco Umbrella Internal
Networks setup does not allow an invalid range to be configured. The basic principle is that the
final octet of your IP range should match the mask for that range. More information about subnet
masks, as well as tools, are easily available from many third-party websites.

You can assign an individual Internal Network policy to a single IP address or to an entire DHCP
scope that's already been configured for your network.
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Domain Management

1. Inthe Umbrella dashboard, navigate to Deployments > Configuration > Domain Management.

Dagloyments | Conflgurano

T e i alan ‘él
© i’ Internal Domains e R

Addd

Want to route certain domains to your local resolver? You've come to the right place. Click " Add™ above to get
started.

Domain Description

[his internal domain applies to:

All ADpliances and Devic ]

Any DNS queries received by the VAs which match a domain on the Domain Management list, or
subdomain thereof, will be forwarded to the local DNS server as described in Configuring your VAs.

The following domains/zones are pre-populated and do not need to be added:
e RFC1918—Non-publicly routable address spaces used only for reverse DNS on internal networks.
All local IP address space for reverse lookups (PTR records) is covered with this entry. Adding in-
addr.arpa reverse lookup zones is not needed.
e _.local—Any domain name with a TLD of .local.

You have a choice of what type of identities are set to respect these internal domains:
e All Appliances and Devices
e Roaming Devices Only
e Virtual Appliances Only

If you do not plan on using Umbrella roaming clients**, you may leave this option at the default setting (All
Appliances and Devices). If you plan on using Umbrella roaming clients, we recommend reading the
following document and document subsection for more information:

*Appx B. Virtual Appliances

eAppx D. Internal Domains

Which domains should be added?

Any domain name which has a forward lookup zone on your local DNS servers must be added. If you
already know which domains to add, click here to skip this section.
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On Windows Server, this information is located in the DNS Manager tool.
1. Open the DNS Manager (Start > Run > and type "dnsmgmt.msc").
2. Expand the Server name and Forward Lookup Zones sections. Any domains listed here are treated
as local by your local DNS forwarders and must be added to the Internal Domains section of the
Umbrella dashboard. This is a critical part of the setup process.

Configure Policies

Before we convert your network to OpenDNS you might want to setup your filtering Policies.
OpenDNS Policies are a top down process, meaning your endpoints will start from the top of the
list and work their way through to the bottom. If they do not get blocked by any policy that is linked
to them, then they will be allowed access.

The bottom Policy will always be Default Policy and this is the state level policy that blocks
Pornography only. It uses the “Centralized Default Settings” Category Setting which is managed
by the state and can only be edited by the state.

This guide will walk you through setting up your own District Default Policy to site above the
State Default Policy so that you can manage your bottom level filter. It is recommended that you
make this a very restrictive policy to be your safety net at the bottom of your policy list.

Before we can create the Policy itself, we need to create the Destination Lists, Category Settings,
Application Settings, and Security Settings.

Destination Lists

For each policy you will need 2 Destination Lists, one will be an Allow list and the other will be a
Block list. These two will be your granular control on each policy allowing you to Block or Allow
websites on a URL basis. If your End Users find a website that is being blocked by a Category in
your Policy and you do not want to unblock the whole Category to allow access to this particular
website, you would put the website in the Allow Destination list.

1. Navigate to Policies > Destination Lists
2. You will see two Destination Lists already exist. Global Allow List and Global Block List
a The Global Allow and Global Block will always be attached to every Filter
Policy and cannot be removed. For this reason, you should be very careful what
you add to these two destination lists.
b If you already have a Whitelist or a Blacklist from another filter, you can upload
using a .CSV file with each domain on a new line, and select Bulk Upload
Domains.

3. To create a new Destination List, click the small blue plus sign at the top of the page.
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4. Type a name and choose whether this is an Allow or a Block list and click Save.
5. Create both a Default Allow and a Default Block Destination List.

« Back To Mulli-org Console

Destnation Lisis @ n

stinanion Lists enoble you to customize \'cmrn alic n o block o auwu vuomamsﬂu.-n apoly those I:num\r ur poficien. Adding wildcards mvnu T blac
damain com will 2 h atlows of bioek subdamain domain com o alap allow 1P addisssas and CIOR ranges for Rnaming Compitars with the Reaming

a

MHew Destinatnon List

List Name

Destnatons in this EL Enould be:

@ Biocked Adiowod

GLEAR

. com DOMAIN

Category Settings

. Inthe OpenDns Dashboard, Navigate to Policies > Category Settings
2. Here you will be able to VIEW the “Centralized Default Settings” Category List but not
edit it. Another Category List should already exist called Default Settings. This one you
can edit but not delete so let’s click on it.

a. To add your own Category Lists in the future, click the blue plus sign at the top of
the page.

3. Navigate through the list putting checks in everything that you want blocked in your overall

« Back To Multi-org Console
t =inilals]
Cogay From Existing
Nowe
CATEGORIES TO BLOCK  SELECT ALL
=1
Acad F ol Govormman U Hadio
i
Adult Themos Hane | Discriminatio Holigio
] ]
At Hoahh and Fitr Rusoarch f Rul
o 1
el Hummiesy Saarel Engy
1
Animae ! Manga | Webcomic Instant Mossaging Soxuality
=4 1 =
Auctions Intornot Watch Foundation Socisl Motworking

a. Always check Pornography when creating EVERY Category Setting. This is
because once a user authenticates to a Policy in OpenDNS, they are then governed
by that policy only. I.E. If Pornography is blocked in every Category Setting for
every policy OTHER than your Students, then when students authenticate and pull
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the Student Policy, they would be allowed to access porn no matter what policy is
above or below them.

b. This filter will be the Default Filter that devices on your network will get if they do
not fit into any ldentity Groups in any other filter.
When you have selected all of the Categories that you want blocked by default on
your network, click Save. Below is the list of all Content Categories.

& COMNTENT CATEGORIES

Categortes SELECT Al
I Adualt [T Have Speech T Private IP Addresses as Host
1 Advertsements 1 Heaith and Medicine 1 Professional Networking
I Aldcobosl 2] Hurmeaosr ] Real Estate
Animals and Pets 1 Humnting 1 Recipes amnd Food

oad

Reference

Arts T Hegal Activities (]

Astrolbogy IBegal Downioads
[Hegal Drugs

Infrastructure and Content Delivery Metwor.

Regional Restricted Sites (Germany]

O

Ausctions 1 Regional Restricted Sites [(Great Britain}

Business and Industry Regional Restricted Sites (taby)

a

Cannakbis 71 Imternet of Things 71 Regional Restricted Sites [(Poland)

]

Chat and Instant Messaging
Cheaating and Plagiarism

Intermet Telaphoay
Job Search

RelEgion
SaasS and B2B

i Child Abuse Contamnt 1 Limegerie and Swir i 1 Safe for Kids
1 Clowd and Data Cemters 7] Lotteries T Science and Techmobogy
i Compater Security 1 Mlicary 1 Search Emngines and Portals

Compauaters and Intermeat

hobile Phaones

Sex Education

i Gon i c wcas and Trade Shows || hMuseums 1 Shopping
1 Cryptocurrensy IZ1 Nature and Conservation T Social Networking
1 Dating 1 Newws Social Science

DFigital Postcards
DFining and Drinking
DY Projects

DroH amnd o™

Dymamic and Residential

Mon- gower g - ®
Mon-sexmad Mosdity

Mot Acticnable

Onliree Communities

Danilimee Document Sharing and Coflaboration

Society amnd Culture
Software Updates
Sports and Recreation
Smreaming SAodio

Smreaming VWideo

1 Education 1 Oniliree Meastings Termorism and YWiolent Extremism
1 Entartainment 1 Dnilinee Storage and Backup Tobacco

7 Extremnme 1 Onilivee Trading Transportakibom

1 Fashiomn 71 Owganizational Email T Trawel

i File Transfer Sesrvices 1 Paranormal URL Shortenars

1 Filter Avoidance |71 Parked Domains Vieapoms

i1 Fimnamce 1 Peer File Transfer 1 Web Cache and Archives

Freeware and Sharewarsa

Persomnal Sives

Weab Hosting

i1 Gambing 1 Personal WPN 1 Web Page Translation
1 Games IZ1 Photo Search and mages I~ Web-bassed Email
i Gowermament and Laww 1 Politics
1 Hacking Pormography
& CONTENT CATEGORIES (LEGACY)
Categorias SELECT ALL
1 Academic Fraud 1 Hate /] Discrimination ] Proxy /] Anonymizer
[ Adult Themes 1 Health and Fitness [ Radio
[ Adware 1 Instant Messaging 7] Religious
1 Ani /M /W 1 Internet Watch Foundation 1 Research | Reference
1 Automotive 1 Im-ADM ] Search Engines
] Blogs ] Im-AGCcom Il Sexuality
] Business Services 1 Jobs /Employment [ Software | Technology
1 Chat 1 Lingerie [ Bikini I~ Sports
] Classifieds 1 Movies 1 Tasteleas
1 Drugs 1 Music 1 Television
1 Ecommerce [ Shopping 1 News [ Media [ Terrorism
= i I Insti 1 MNon-Profits [ Wideo Sharing
[ File Storage [ MNudity 1 Visual Search Engines
[ Financial Institutions [ P2P / File sharing ] Web Spam
] Forums / Message boards [l Photo Sharing [ Webmail
] German Youth Protection [ Podcasts
] Government 1 Portals
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Migrating Legacy Content Categories
Umbrella has reorganized the content categories and when you go to the All Policies page you will see an option at the
top to begin migrating Legacy Categories to Talos Categories. The Migration Tool will walk you through the whole
process. To begin click on Migrate Content Categories. This will open the Content Category Migration Tool and explain
the Deprecation Phases. Click Next.

Content Da.tegory Migration Incomplete. ) . . I MIGRATE CONTENT CATEGORIES I
You must migrate all legacy content categories. For more information, see Umbrelia's Help

Content Category Migration Tool

o Intro Migrate Canfirmation

Cisco Umbralla's content categories are changing so that they align with the content categories used by the rest of Cisco's secunity products. To
achieve this alignment, you must migrate your current content categories to Umbrella's new content catejori Use the Content Category Migration
Tool to achieve this goal. For more informaton about the about the Content Category Migraton Tool, see Umbiella's Help,

Phases

The migration to new content caiegories will oecur over the course of the following phases:

| 1 | Migration Phase: 3 months
o Mew and legacy content categories can be added and removed from policies,
= New and legacy content catsgories available to reports.

| 2 | Deprecation Phase: After Migration Phase for 1 year
e Legacy content categories removed from all policies
o Legacy content categones available to reports.

L .-3 | Removal Phase: At the end of the Deprecation Phase

= Legacy Categories emoved and unavaillable

Atthe end of the Migration Phase any remaining Legacy Categories in use within policies will be automarcally migrated to New Categones. ‘
NEXT

CANCEL

Content Category Migration Tool

(<) Intro & Migrate Confirmation

Select Umbrella's legacy content categories for migration to Umbrella's new Talos-based content categories. For more information, Umbrella’s Halp.

DOWNLOAD MIGRATION REPORT

0 Legacy Category — MNew Category DNS Policy Impact « Identity Impact

(1| P2F { File sharing —_ Peer File Transfer 3 DNS Policies 7 Identities o
() Radio — Streaming Audio 3 DNS Policies 7 Identities R
(3] Adult Themes — Adult 3 DNS Policies 7 ldentities o
] Tastelass — Extreme 2 DNS Policies 7 Identities ~
O Proxy / Anonymizer — Filter Avoidance 3 DNS Policies 7 identities st
(] MNusdlity —_— Mon-sexual Nudity 3 DNS Policies 7 Identities e

——

You can click on the DNS Policies that will be impacted and it gives more info. On the Migrate screen check the box next
to the Legacy Category to be migrated and click Next.
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Content Category Migration Tool
l:// Irtro (~) Migrate a Confirmation

Do not close or refresh your browser page during the migration process. After Umbrella completes the migration process, legacy categories are available
until the Migration Period ends.

After migration, legacy categories can be manually added to policies until the end of the migration period. Please do not close or refresh your page
during the migration process

I Ganfinm migration I

4

CANCEL | BACK | MIGHATE

On the Confirmation screen, Check the box next to Confirm migration and Click Migrate.

Content Category Migration Tool

() Inwro () Migrate e Confirmation

Migration Complete

Selected l=gacy content categories have been successiully migrated 1o Umbrella's new content categories.

2 ¢

When the Migration is Complete, Click Close. Back under the All Policies screen you will now have a confirmation that
the Category Migration has completed.

.| Category Migration Gomp
Alltegacy content categories have been successfully migrated or vour policies did not previously contain any legacy categories, For mare

informaticn, see Umbrella's Help

Below is a list of the Legacy Category and the new Talos Category.

Legacy Category Talos Category
Academic Fraud Cheating and Plagiarism
Adult Themes/ Adult Adult
Anime/Manga/Webcomic Entertainment
Automative Transportation

Blogs Online Communities
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Business Services

Business and Industry

Chat Chat and Instant Messaging
Classifieds Auctions

Drugs Illegal Drugs
Ecommerce/Shopping Shopping

Educational Institutions Education

File Storage

Online Storage and Backup

Financial Institutions

Finance

Forums/Message Boards

Online Communities

German Youth Protection

Regional Restricted Sites (Germany)

Government

Government and Law

Hate/Discrimination

Hate speech

Health and Fitness

Health and Medicine

Instant Messaging

Chat and Instant Messaging

IT-ADM/ IT-AGCOM

Regional Restricted Sites (ltaly)

Jobs/Employment

Job Search

Lingerie/Bikini

Lingerie and Swimsuits

Movies Streaming Video

Music Streaming Audio

News/Media News

Non-profits Non-governmental Organizations
Nudity Non-sexual Nudity

P2P/File Sharing

Peer File Transfer

Photo Sharing

Photo Search and Images

Podcasts Streaming Audio

Portals Search Engines and Portals
Proxy/Anonymizer Filter Avoidance

Radio Streaming Audio

Religious Religion
Research/Reference Reference

Search Engines Search Engines and Portals
Sexuality Adult
Software/Technology Computers and Internet
Sports Sports and Recreation
Tasteless Extreme

Television Streaming Video
Terrorism Terrorism and Violent Extremism

Video Sharing

Streaming Video

Visual Search Engines

Photo Search and Images

Webmail

Web-based Email
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Application Settings

You can also block application categories or specific apps by configuring application settings in your policies.

1.

2.

3.

Navigate to Policies > Policy Components > Application Settings.
Expand an existing policy or click Add to create a new policy.

Select application categories to be blocked, or expand a category to select specific apps.

Applications To Contral

| Search for an application

3 Custormer Relationship Managemeant (CRM)
» E-Commence

= ~ Games

# Brave Frontier Block 43

Electronic Arts
Mail.ru Games

Microsoft Xbox Live

Alintorrin

When some, but not all apps in a category are blocked, the checkbox next to the category shows a dash. When all apps in a
category are blocked, the checkbox shows a checkmark. When no apps are blocked, the checkbox is empty. When settings are

changed and saved in an existing policy, the Application Control Change Summary appears. Click Proceed after reviewing the

summary.

Application Control Change Summary

Please review the summary and changes before proceeding to the next step.

The following applications will be blocked:
U Example App, plus 27 more (Anonymizer)

The following policies will be affected:

Default Policy

LE:TUIO  PROCEED
it
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Block Page Bypass

Block Page Bypass will not be available for any apps blocked at the domain level in Application Settings. The block page will be
a static block page without the ability to enter Block Page Bypass codes.

Note: For more application blocking options, use application settings.

5. (Optional) Check Label application as and select a label if you want to set a label in addition to blocking the app.

6. Click Save.

Security Settings

Now we will adjust the Default Security settings for your network. With Category Settings and
Destination Lists, you create a new one every time you need to create a new policy. With

Security settings, you have this option as well but it is more common practice to see the Default
Security Settings used in 90% of the Filter Policies. If you need to create a new Security Setting,
click the Small Blue Plus Sign at the top of the page.

Navigate to Policies > Security Settings
Select the Default Settings
At the bottom, put a check mark in the box next to any box you want to have blocked on your
network. Most common options that are chosen are:
a. Malware
b. Command and Control Callbacks
c. Phishing Attacks
d. Potentially Harmful Domains
e. DNS Tunneling VPN
f.  Cryptomining
4. Click Save.
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Default Settings e SQratons Ls e "

Setting Name
Default Settings

Ml c._s’e

Websitsz snd othar ssrvers that host mslicious sofrwsrs, drive-by downloads exploits, mobils threstzs and mors.

—  Mewly Sssn Domsins

' Domsing thst have bscoms sotive vary recemtly. Thase are oftsn ussd in new stschke.

Commasnd snd Control Csllbscles
Prawvant compromised devices from communicsting with atteckera” infrestructurs.

Phishing Attschks

Fraudulsnt websitss that sim to trick usera into handing over personal or finsncisl informstion.

—  Dymamic DMS
Block sites thst are hosting dymsmic DMNS contant.

Potentislly Hermful Domsins

Domsins thst sxhibit suspicious behsvior and may be part of an stisck

DMES Tunnsling WPMN
WPMN ssrvicas thst sllow ussrs to disguiss their traffic by tunnsling it through the DNS protocol. Thess can bs ussd to bypsss corporste policies regarding

scossa and dats transfer

$838 33 3

Cryptomining

Cryptomining sllows onrganizstions 1o control cryptominer scesess to mining pools snd walb minersa.

INTEGRATIONS ‘

Policies

You can now create your new District Default Policy. In your Policy List you will see a Default
Policy. This policy will always be at the bottom of your list and it contains the Central Settings
that are managed by the state. You cannot edit or remove this policy.

1. Navigate to Policies > Policy List
2. Click the Blue Plus Sign at the top of the page
3. Since this is a District Wide Default Policy we will be selecting ALL Identities

a. For Student, Faculty, etc policies, click on the AD Groups identity and search for the
corresponding Active Directory Group.
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What would you like to protect?

Select Identities

e B ekecied REMOVE ALL
i+  AD Groups 4+ AD Groups
& ADUsers & ADUsers
[ AD Computers [J AD Computers
& Networks & Networks
1 Roaming Computers 1 Roaming Computers
a8 Mobile Devices & Mobile Devices
Q Sites @ Sites
&, Network Devices & Network Devices

All Identities I

4. Click Next
5. On the “What should this policy do?” page, click Next

Vwhat should tt j

this pohcy do

Enforce Security at the DNS Layer

a

Inspect Files

a

Limit Content Access

Apply Destination Lists

ADVANCED SETTMNGS ‘

S . m

6. On the Security Settings page, click the drop down and select Default Settings then click
Next

a

a. The Security Settings can be edited from this page by clicking Edit but changes made
here will also be made to every policy that uses the Security Settings component
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that has been chose here.
OW 7@&‘:@1 o: et °smkf>aqes 7°&mméry

Security Sen

w

38 sspurny- ety Chck Edit Sarung 10 make chang

CATEGORIES TO BLOCK g7

U Wab: rs that host mal

ctware, drve-by downicaos’expltiis. mabde thresi=ant mors

( Newly Seen lomains

Do hat fave

giten Lsed innew sl

U Command and Control Callbacks

tomMpromses devices

Pravent tackars infrasruidie

T eanvTRiInGEEng witly

U Phishing Attacks

Frauculent wets

ot Information.

st aim Lo trck users nto nanding over personal

C Dyriamic DNS

= thatars histingdyn

[- Potentially Harmful Domains

Dornzi

U DNS Tunnelfing VPN

VEN Ve O

1 These £59-58 Use0 10 by Eass carpersie ¢

nd dat3 frans!

CANCEL
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7. On the Content Page select Custom, then from the drop down on the top right, select
Default Settings and click Next

o Securizy 0 Content

i Contant Arpeca

Catsgoriss to Block - High
® High

» Aduft Thames » Adwars

s Acohol » Chat

» Ciasifisde « Dating
Moderate » Drugs « Fis Storage

» Forums / Meszsgs boerdis » Gambling

« Gama= « Hate | Diacrimiration

« Instort Mescaging - Lingesi

* Nudity « P2P | Flis shering
Low » Photo Shanng « Pomography

o Proxy { Anoaymizer » Saxuality

» Socisl Networking

« Video Sharing

« Weapons
» Custom P

° Security e Contsnt Uc Destnstions E Bock Pagas Summsry

e (ARt e
L wONent ~CCEsS
Custom Setting '
High
Dofoult Sottinge
Csnv sttings
TALL
Defo.
Moderate
scu
ants Calsgornes
Shaity’s Defaul Cstegories
v
Low Shopping
REATE NEW ING
nancial Insttutons Forums / Message boards
& Gambiin v Games
o German Youth Protection Government

® custom

w Hate/ Discrmination Health and Fitness
Hilmar @ Inss=nt Mascannn '

Gy i ‘ m

8. On the Applications Page choose to use the Default Settings or if you have created a
custom Applications Settings for this specific policy select it from the drop down list and
click Next
a The Applications Settings can be created or edited from this page but changes made here

will also be made to every policy that uses the Application Settings component that has
been chosen here.
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o Security ° Contsnt e Applications e Destinations @ 2 Mors:

Control Applications

Select applications or application categories you'd like to block or allow for the useds in your grganization

Application Settinga

| Default Sattings A

|I Dsfault Ssttings I

CREATE NEW SETTING

1
| SEEITH 10T 81 SRpICaton

B » AdPublighing

™ 3 Anonymizer Elock

I » Applicstion Devslopment snd Tssting

) » Businses Inwsfligence

B > cBmM

| % Cloud Storsge

| » Collsborstion

L

CANCEL
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9. On the Destinations Page, your Global Block and Global Allow Destination Lists will
already be populated here. Put a checkmark in the box next to your Default Allow and
Default Block list on the left hand side. You will see them populate in the area on the right
hand side along with the Global Allow and Global Block lists.

a. Your Global Destination Lists will be in every policy and cannot be removed so be
careful with your Destination Lists.

9. Click Next
° Security g Content 9 Destinations Bicok Psaes Summary

ADRPNY LJESTINATION LISTS ADDNEW LS

Q = 2 Allow Lists Applied REMOVE ALL

[ Showing: Al Lists v .5 Total @ Dsfault Aliow

¢ & Dsfault Allow @ Global Allow List

¥ & Dsfoult Block 2 Block Lists Applied REMOVE ALL
® Globs! Allow List @ Dafault Block
@ Global Biock List & Global Block List
@ network liat

All Destination Lists

10. Choose weather you want to use the Umbrella Default Appearance or Custom Appearance then

click Next.
° Seauvity O Content ° Destinati=nz o Rlock Pagas Summary

Use Umbretla's Default Appearance

® Use a Custom Appearance

Centralizad Default Scttings

11. Name your policy District Default Policy and verify that all of your settings are correct.
Once you are done, click Save.
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g Security Q Contant G Deztnstions Q Bicck Psges O Summary

J~1
o

(4]

L

Policy Name

U 28 ldentities Affected U 4 Destination Lists Enforced

U File Ingpection Enabled
[:] Security Setting Applied: Default Sattings

l’] Custom Block Page Applied

U Content Setting Applied: Default Settings

=

The policy that was just created will be the Default Policy for the District. If a user does not
authenticate against Active Directory, that user will be filtered according to this policy. That is why
it is recommended to make this policy so strict and also why every Identity is selected at the
beginning of creating this policy.

Follow these steps again to create a Student, Faculty, and Administration policy but do NOT select
every ldentity. Instead navigate into AD Groups and search for the corresponding Active
Directory Group. You will need to create new individual components for each new policy.

OpenDNS Policies are a top down process. This means that when a user tries to authenticate to a
policy, it will start at the top of the list and work its way down. That is why your most LEAST
restrictive policies, 1.E. IT or Administration, should be at the top and your MOST restrictive
policies, 1.E. Students and the District Default Policy, should be at the bottom.

Policy Advanced Settings
After the policy has been created, clicking on the policy again will display page that is very

similar to the summary page seen during the last step of the policy creation. The policy can be
edited here as required. At the bottom is a drop down called Advanced Settings.
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District Default Policy

Policy Nams

0 Identities Affected (] 2 Destinsation Lists Enforced

Security Setting Applied: Default Settings
File inspection Not Enabled

Content Setting Applied: Default Settings U Custom Block Page Applied

m
(o]
f

m
m

Clicking the Advanced Settings drop down will display a few advanced features.

1.
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The first option is to Enforce SafeSearch. SafeSearch is an automated filter of pornography
and other offensive content that’s built into search engines. If anyone enters an inappropriate
or suggestive phrase, no results will be returned that could be considered unsafe or

problematic. This method of enforcing SafeSearch is supported for Google, YouTube, and
Bing.

SAFESEARCH

¥ Enforce SafeSearch

Enfarce SafeSearch for queries sent to supported search engines Learn More

The second option listed is Allow-Only Mode. This option disables any block settings in
the policy because it will block every single web connection by default. With this option
enabled, users who authenticate to this policy will ONLY be able to access the websites that
are listed in the Allow Destination Lists. This is useful for students who have broken the
rules to many times. An Active

Directory group can be created called No Internet. A Policy would then be created using
only that AD Group as an identity. This policy will then be moved to the very top of the list.
If a student needs internet access for specific sites for class work but are no longer allowed
to access anything else, then they can be moved to the No Internet Group in Active
Directory which will cause them to authenticate to this policy and only be allowed access to
the websites listed in the Allow Destination Lists.

Aliow-Only Mode



3. The final option is Logging. This is set to Log All Requests by default and should remain
that way on every policy. Without this option enabled, Activity Search will no display any
results resulting in no longer having the ability to pull reports.

® Log All Reguests

Log Only Secunty Events

Don't Log Any Requesis

Deploying Umbrella Certificate

Advanced Umbrella features, such as IP Layer Enforcement and the ability to block your own custom URLs
require that the Cisco Root CA be installed locally.

In addition, by installing the certificate, you avoid a common problem with block pages that your users may
encounter. When HTTPS enabled domains are blocked by your policy, Cisco Umbrella presents a block page to
you which is also served over HTTPS. This block page is encrypted with a certificate signed by the Cisco Root
CA. In order to avoid certificate errors when accessing the block page, you must install the Cisco Root CA in
your browser, or if you have a network of computers, in your users' browsers.

Why Deploy Certificate?

Umbrella’s Block Page and Block Page Bypass feature present an SSL certificate to browsers that make
connections to HTTPS sites. The certificate will match the requested site but will be signed by the Cisco Root
Certificate Authority (CA). If the Cisco Root CA is not trusted by your browser, an error may be displayed.
Typical errors include "The security certificate presented by this website was not issued by a trusted certificate
authority" (Internet Explorer), "The site's security certificate is not trusted!" (Google Chrome) or "This
Connection is Untrusted" (Mozilla Firefox). Although the error is expected, the messages displayed can be
confusing and annoying and you may wish to stop them from appearing.

To avoid these errors entirely, install the Cisco Root CA in your browser, or the browsers of your users (if
you're a network admin). This can be done on a per-browser, per-machine basis for personal use or small
deployments. For larger deployments, an automatic installation through Group Policy (GPO) can be done. Note
that the automatic installation through GPO will only work for users with Internet Explorer, Edge, or Chrome
on Windows systems. As such, if your network includes some users who use Firefox or Safari browsers, and for
users on non-Windows operating systems, the manual installation procedures must be followed.
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Download Certificate

In the Umbrella console under Deployment there is a link to download the root certificate which is necessary for
proper processing of the Umbrella block page for destinations which are https:// encrypted sites. This certificate
is also necessary for the option of decrypting DNS requests related to https encrypted sites.

<Back To Muti-org Cansole Ny

Ceploymenis [ Configuration

atltat]na g T
© ‘it Root Certificate

Get Started

Umbrells's Bock Pags fasture pressnts an 351 certificats ta browsers thet make
blocksd stes. The cartificats will match ths reguested site but will be signsd by the Cisco Root
Certificats Authority (CA).

DOWNLOAD CERTIFICATE

To werify your downioad, check the Cizco cerifinata’s SHA 1 thumbprint end ansurs that it matchez
C5:00:11:32E0:ADFB:AD:3E:33:03:2A-E6:0A-5C:8FAD30:E8:24

cannecton: to

x, and Seiari on thoss

¥an eciosz Chrome, Fi

0. pleas
d-cisco

import-information/

TROURL ESHOOTING

This certificate can be pushed to all windows workstations with group policy, and to Chromebooks with Google
admin. You can use the Apple MDM to push it to iOS devices.

Download the certificate to a network location that is accessible to the device from which you will be
implementing the distribution.
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Deploy Certificate with GPO

To deploy the certificate to Windows devices using group policy, follow the instructions below:

1. On a domain controller in the forest of the account partner organization, start the Group Policy

Management snap-in.

[ Server Manager = (8] x
Manager * Dashboard ]
8 Cashboard WELCOME TO SERVER MANAGER
i Local Server ,;i 'ﬁmﬁ £
ii All Servers [ /@, File  Action  View Window Hep
i anDs s 23 28 R HE
18 DHep & Group Policy Management Defauit Domain Policy .
8 pNs 4 4N .Ft.}re;t: TL.‘TI'BGMAIN.IDr_a: Scone | Deteils I [rrr— I Diekegaion I E |
4 4 Domains %
B File and Stor 4 54 TESTDOMAIN Joeal Hnlos i
& HyperV . Default Demain Policy Disaley lirkes in this bestion: TESTDOMAIMN local ¥
3 Local ademin The: folawing sies. domnins. and 0 s am linked to this GFO:
Domain Controllers oo 5 i PR F
Fon 1o =
b = Lab Computers A
4 B Geop Policy Objécis 4 TESTDOMAIN Iocal Mo Yeg il
Domain Controlizrs Poli ] I 5 Hide
Domain Policy - 5 '
| Local admin Security Filtering
F -'~l' WA Filters The settings in this 5RO can only apply to the folowng groups, uses znd computers:
b (3 Starter GPD: = =
2 Heame
b g Sites =
b W% Group Palicy Madeling Mrrtind s
) Group Policy Results
Add_ |  Femove ] P
WMI Riltering
Thia GPD'is knked to the Followng WM fiker:
<nona vl | Goen
< [ >
BFA results BFA results

Y
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2. Find the Default Domain Polity Group Policy Object (GPO). Right-click the GPO, and then click Edit.

[ Server Manager = (8] x

rer Manager * Dashboard ' Menage  Tooh

M WELCOME TO SERVER MANAGER

B Locet Sever | b Group Policy Management [=[c
Bi allServers || G File Achon  View Window Hep BEE
f# ADDs e 27 28 X BE
1 CHeP & Group Policy Management Detault Domain Policy L
2 of ALY | = = it
2 NS e Sco02 | Dietriks | Seftngs | Dekegsbon | Sehs |
4 4 Domains %
B File and Stor 4 54 TESTDOMAIN Joeal Hnlos
E HyperV . Defzult Domain Policy Disaley lirkes in this bestion: TESTDOMAIMN local ¥
> iw Local admin The folawing skes. domnins. and O s are linked to this GPO:
13 Domain Controllers = Erforoad T Bt P
Location e nk Enzhils:
¢ o Lab Computers 4
] TESTDOMAIN local M e
4 | 5F Group Policy Objects # . 2 = o |
efault Domain Controllrs Poli P W : Hide
Default Dpmeie Nk — - 3 -
ceal adr Edit... -
b Ly WM Filkers GPO Status Y LGROcan only appy o the folowng groups, wsers, end computers:
b [ Starter GPO: Back U, -
% ek Restore from Backup...  Users
7 Group Policy Results Import Sectinge...
Szve Repart.. H- = i
Visw s -
New Window from Here
i to the followerg WM fiker:
- Copy w Coen
< i Delete
\|Open the GPO editor Rename
BF Frfrmsh BFA results
Hefp

L5 e Y LT

3. In the console tree, open Computer Configuration\Policies\Windows Settings\Security
Settings\Public Key Policies, right-click Trusted Root Certification Authorities, and then click

Import.
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4. On the Welcome to the Certificate Import Wizard page, click Next.

5. On the File to Import page, type the path or browse to the appropriate certificate files and click

Next.

File Action WView Help Action  View  Hedp

g Group Policy Management Editor =B x ] i Group Policy Management Editor [=18 x| servers

1 daEaasBm

e= alm ol 5@ @
T - —— + 1 Plicies - koeiitg = Issuied By
o il 5
P 1his view, P
Y L g
. d t |l * This2C v Downicads v 4] [ Seacch Dowrioads 3|
Filo ta lmpart X B v
Spacky the file pou wark b import, Crganize ¥ New folder EE i ]
o Favarites Name Diate modified Type
plisai i Deslor WCkUnbckaRootCh  W4en@23Rd oy
|wamhdmnnmnr\uwnlnnd9,ﬂn_mmlh_m_mr| | Browss., | 4 Dowrdoads
&p Recent places
Noka: Mara than ana cartificate can ke stored b & siogla fils in the folewing formats:
=
Perzonal Information Exchange- PRCS #12 [ PEX,FLZ) i This PC S
Cryptagraphic Message Syntax Stndard- FRCS #7 Centificates | FTB) I Deskton
Micraeaft Seralized Carttfieats Stara {.55T) Il Documents |
J4 Dowrloads | s
B Music
E Picnures
B Vvidecs
% Local Disk {C)
] [ P it B3 L] | 2
File mame: | Cisca_Umiresf_foot CA | [cenificate Fie C.oentan ~|
o ]
E o s
+ T2 Network Access Protection + 0 Network Access Protection ||
} 3 Application Controi Pakicies | + L1 Angscation Controt Policies L. | : d
il [ X L iL 'l 2Ll A2

6. On the Certificate Store page, click Place all certificates in the following store, and then click

Next.
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. On the Completing the Certificate Import Wizard page, verify that the information you provided is

accurate, and then click Finish.

Group Policy Management Editor =B % ||
Fle Action View Help
e 20 as BE

d &) - Contificate Import Wizacd.

Completing the Certificate Import Wizard

The SErBcAN will be Mp0rad T you chok P

You hove spacied e fotmsng setings:
P ——

Conent Certficste

Fig Nama Loydsers Agmmestrater  Downloads' Cooe_Urbreda |

| Fanishy Cance!

Deploy Certificate to Chrome Devices with Google Admin

To distribute the certificate using Google Admin, do the following:

Sign in to the Google Admin console.
Click Device management.

On the left, click Network.

Click Certificates.

(Optional) On the left, choose the organizational unit where you want to add the certificate.
Note: The top-level organization is selected by default to give all users (including those in
suborganizations) access to any added certificates.

Click Add Certificate.

7. Choose the certificate file to upload and click Open.
Note: DER-encoded certificates are not supported. Chrome devices only accept PEM format.

ok wbdPRE

o

8. (Optional) If the certificate will be used as a root CA for an SSL-inspecting web filter or to allow the
browser to validate the full digital certificate chain of servers, check the Use this certificate as an
HTTPS certificate authority box.

9. Click Save and then Done to confirm.

Verify the CA on managed Chrome devices

1. Goto chrome://settings/certificates.
2. Click Authorities.
3. Scroll down to see the newly-added CAs.
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CAs set up in your Admin console are highlighted as follows:

Certificate manager

Your Certificates Servers Authorities Qthers
You have certificates on file that identify these certificate authorities
certSIGN

certSIGN ROOT CA

Chromedepioyment

Chromedeployment i)

This certificate has been Installed by your system
administrator. Yority

With respect to your iOS devices, contact your management provider or install each device

with the certificate individually.

ByPass User
Setting up your Block Page Bypass

An important step when configuring policies is to ensure that you're giving the right information to your users if
they are blocked under Security or Content categories. As the Umbrella administrator, you may wish to exempt
users from being blocked during certain times and you can set up the rights to do that as well.

Some helpful terms to know:

o Block Page—The page that's displayed in the browser when a user of your Umbrella service tries to go to a
website that's been blocked under the category defined by the policy for the Identity that user falls under.

« Block Page Bypass—The method by which certain users who have been given special authority can bypass
a normal block page. There are two ways you can bypass a block page: having a user account (a bypass user)

or having a special code (a bypass code).

« Block Page Bypass User—A special user account that gives the rights to certain individuals or a group of
individuals to go to blocked sites while still being part of the enforcement given to the larger policy group to

which they they belong.

« Block Page Bypass Code—A code that can be given to individuals or groups of individuals to allow them to
go to some or all blocked websites until such time as the code expires.

Not all categories can be bypassed. If a user is blocked for a Security or Malware category, the site is
considered malicious and should not be accessed under any circumstances. If you think a domain shouldn't be

blocked, please email us at security-block@opendns.com.

55|Page



If you'd like to know more about a block or have us review it in more detail, open a case by emailing umbrella-
support@cisco.com with information about the domain and our support and security teams will review.

The following policy settings can be bypassed:
o Content category blocks
« Destination list blocks—these are destination lists you've created

o The phishing security block

Setting up a Block Page Bypass User

A "Block Page Bypass" user is special username and password that can be given to one or more users in order

to provide them with rights to bypass pages that are typically blocked through policy settings. This user can be
thought of as being a special set of rights that are given to individuals as required. The Block Page Bypass user
has no ability to log into the dashboard or do any administrative functions other than bypass blocked sites.

1. Navigate to Admin > Bypass Users. Alternately, the block page bypass user can be created by editing the
Block Page Appearance in the summary of a policy. The edit for this setting is in the lower right corner of
the policy summary.

Add New Bypass User

Bypass User Description

New Bypass User

Bypass User

Select a bypass user

This bypass user can:

® Bypass everything Bypass specific categories and destination lists

2. From the Bypass User drop-down list, choose a <user>.

When a block page shows up, the user then enters their credentials and bypasses it.
Select how the user can bypass a block page.

Click Save.

B w

The "Block Page Bypass™ user gives the rights to certain individual people, or a group of people to go to
blocked sites while still being part of the enforcement given to the larger policy group they belong to.
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Create New Bypass User
This user will be able 1o bypass blocked destinations.

Bypass User Description

Matt's Bypass user
Bypass User

Matt Prytuluk

This bypass user can:

Bypass everything @ Bypass specific categories and destination lists

Bypass Categories

Bypass Destination Lists
Academic Fraud

B Adult Themes
Adware
Alcchol

Anime/Manga/Webcomic

To setup a brand new bypass user, that is, an account with rights to authenticate against the block page and
continue browsing, first, create the user with the Block Page Bypass role.

1. Navigate to Admin > Accounts and click the + (Add) icon.
2. Choose Block Page Bypass from the drop-down list.

New| Bypass user BPB User + | | (UTC-07:00),

newbypass@cisco.com e e

3. Click Create and in the pop-up modal click Yes to configure Block Page Bypass settings for the user.
The Add New Bypass User page opens (Policies > Bypass Users).

Configure this Block Page Bypass Account

You have created an account that is a Bypass User role. Would you like to configure this
account's Block Page Bypass settings now?

NO THANKS YES

4. If you click No Thanks, you can change the settings for the user you've created under Admin > Bypass
Users or add the settings as part of the policy summary as described earlier.
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5. Add a new bypass user and click Save.

Add New Bypass User

Bypass User Description

New Bypass User

Bypass User

Select a bypass user

This bypass user can:

® Bypass everything Bypass specific categories and destination lists

Creating a Block Page Bypass Code

A Block Page Bypass Code is a code that can be given to users through email, instant messenger or the phone to
allow an instant bypass of a particular blocked page.

1. Navigate to Admin > Bypass Codes and click the + (Add) icon.
You can also access this page from the Summary page of a policy. Click Edit for the Block page applied.

2k Page Setbngs

Bypass Codes @

This typass code can.

®  Bypass everything Bypass specific categories and destination lists
This bypass code will expire on:

2022-06-25 m 11:58 PM -

2. Set the code to either allow access to all sites or a subset of the content category or destination lists you've
defined.

The code can be set to expire at a day in the future and at an hour of that date.

Click Save.

B w

Removing a Bypass Code

1. Navigate to Policies > Block Page Settings > Bypass Codes.
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2. Expand the code you want to delete and click Delete.

Legal teamn bypass code OABNT Everything

Bypass Code Name
Legal team bypass code
Code: OAGN1

This bypass code can:
@ Bypass everything Bypass specific categories and destination lists
This bypass code will expire on:

2018-02-03 i} 11:59 PM

DELETE

Applying Bypass Codes/Users to a policy

Before you will be able to use your new bypass user or bypass code, you must first link it to a policy!
1. Navigate to Policies > All Policies

2. Click on the policy you want to apply the bypass user or code to.

3. Click Edit under the Block Page that is Applied.

4. Expand either Bypass Code or Bypass User and select the user or code you want to apply.

5. Click Set & Return, then SAVE!

Interacting with a Block Page As a User

As an administrator, you can preview the block page; however, not all elements of the page will be accurately
reflected in Preview Mode. This is a problem that's being worked on and will change in the future.

As a standard (non-bypass) user, if you were to go to a website blocked under your Umbrella policy, you would
see a standard block page like this. This example has a custom block page message that includes a link to an
acceptable use policy from this organization, as well as a custom logo for this organization.

Note:

Keep in mind that the block page bypass will not work with domains blocked due to malicious activity (such as
malware or phishing). You can only access the bypass block page if the domain was blocked due to content
category settings or domain block lists. The "Admin" link will not appear if the domain was blocked as
malicious activity.
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At the bottom of the block page, there are two hyperlinks that may appear:

e Contact your network administrator—Allows a user to email the administrator if the user thinks the block

is in error.

e Administrative Bypass—This allows a user with a bypass user or a code to access the part of the page that
asks for that information. Below is the same block page for a policy that has both a user and a code

configured for it.

asco Cisco Umbrella

This site is blocked.

familydoctor.org

Sorry. familydoctor.org has been blocked by your nefwork administrator.

» Diagnostic Info

After clicking on the Administrative Bypass link you will be able to authenticate with either your Bypass User

or Bypass Code

asco. Cisco lUmbre

d

This site is blocked.

familydoctor.org

Block Page Bypass is a feature thal aliows aulhorized users to bypass this biock page. I you're
authorized, you can log in with your Cisco Umbrefia credentials. Otherwise, you can use a temporary

code provided by your network administrator

Email Address (or Usemame) Bypass Code
Password i

Your Password?

Your IP address is 55.204.79.150

After you enter your email/password or bypass code and click bypass you will see the following box
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csco CISCO Umbrella

You are now signed in.

Contmue browsing at famitydocton.org

Terms | Privacy Policy | Contact

You can now click on Continue browsing at <URL> and continue to the site. A popup box will come up and
needs to stay open until you are finished with the bypass. When finished click Log Out to end your bypass
session.

athan

asco CIsco Umbrella

Block Page Bypass
You ara currently using bypass code TT**.

This code expires in 11 hours.

Terms | Privacy Policy | Contac
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Chromebook Client

The Cisco Umbrella Chromebook client provides DNS layer protection for Chromebook users whether they are connected to

your networks or remotely, no matter which Chromebook device they use.

You can use the Chromebook client to accomplish three main goals:

e Protection from phishing: Protect against phishing threats automatically with Umbrella’s global network data
and predictive intelligence to discover internet infrastructure used to host phishing sites—before employees or
students ever receive the phishing email.

e Content category filtering: Gain visibility and control of content on and off network. Organizations can help
ensure compliance with the Children’s Internet Protection Act (CIPA) utilizing over 80 content categories, as
well as their own allow and block lists of domains.

e Per-user visibility and policy: Enforce policy-based protection whether users are on or off the network. If user
becomes infected, pinpoint activity to a specific user to expedite remediation.

How the Umbrella Chromebook client works

Chromebook users are protected by the Cisco Umbrella Chromebook client in the following sequence:

e Auser enters a URL in the Chromebook browser.

e The Chromebook client extension copies the domain name from the URL and sends it to the Chromebook client
app.

e The app creates an EDNS query, then sends the DNS request, including the EDNS information, to the Umbrella
resolver.

e Depending on the applicable policies applied in the Umbrella dashboard, the resolver responds by either
blocking the IP address of disallowed domains or resolving the IP address in the case of acceptable domains.

INSIDE CHROMEBOOK
—
B0 g
o
=
Chrome Browser Chrome Chrome App Umbrealla
Extansion Local ONS Server Resolver
Auto register device
Auto register device
Get Policies

Q . |

[ : Apply Policies |
View Reports o /V'
Manage Devices —_—

Umbrella Dashboard

The Umbrella Chromebook client is deployed using a Chrome extension and application available on the Chrome Web Store.
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Installation Guide

There are three parts to this installation:

Downloading the configuration file from the Umbrella Dashboard
Installing the Cisco Umbrella Chromebook client extension on your Chromebooks
Installing the Cisco Umbrella Chromebook client application on your Chromebooks

In addition, you can find instructions for removing Cisco Umbrella Chromebook software in the last section of this guide.

Prerequisites

In order to install the Cisco Umbrella Chromebook client, you must:

be a G Suite admin account in order to log into admin.google.com.
have a valid Umbrella dashboard login.

Chromebooks must have Chrome OS v55 or later.

Chromebooks are not in Kiosk mode

Port 53 UDP accessible to 208.67.220.220 and 208.67.222.222
https://registration.polaris.qg.opendns.com is accessible

Unsupported :
o Chrome browser on OS X, Windows, and Linux

o Devices running variations or third-party distributions of Chrome OS, such as Neverware CloudReady.

Networking Requirements

The Cisco Umbrella Chromebook client uses the following ports:

Port and Protocol Source / Destination Notes
53 (TCP + UDP) 208.67.222.222/32, Used for EDNS Queries
208.67.220.220/32
443 (TCP) registration.polaris.qq.opendns.com HTTPS - Used for registration
443 (TCP) Virtual Appliances Used for the Trusted Network Detection feature.
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Recommendations
Disallow the incognito window
for Chromebook users in the G
Suite Admin Console.

= Google Admin Q  Search for users, groups, and settings (e.g. add domain)

Device management > Chrome > User Settings
ORGANIZATIONS Search settings

Idle time in minutes (leave empty for system default)

Action on idle

Steep (default)

Action on lid close

x| Sleep (default)

Lock screen on sleep

Allow user to configure

Incognito Mode Incognito Mode
e et Disallow incognito mode ?»
Students
Teachers
Browser History Always save browser history $
Inherted
i Clear Browser History Clear Browser History ¢
Inhesited

No policy set (default = Allow clearing history it

Implementing Trusted Network Detection

If you are implementing Trusted Network Detection, Cisco Umbrella recommends that you check your DHCP server to make

sure that it is providing Chromebook devices with the same VA IP address as other devices on your network.

Part 1: Obtain the confiquration file from Umbrella

The configuration file contains the information required for the Cisco Umbrella Chromebook client to work with Umbrella.

1. Loginto dashboard.umbrella.com
2. Open Deployments, then select Chromebook Users.
3. Select Configure, then download the configuration file:
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Configure Umbrella Chromebook Clients
Protecting Chromebook Computers

Enablz Umbrella security for your Chromebooks by installing the Chromebook
client Extension and App. You configure the Umbrella App by using the Google
Admin Console to uplead this data file

1. Download your organization's configuration file from the link below:

CHROMEBOOKCONFAG JSON
{ Size ~0.1 kB )

2. Install the Chromebook client software (Extension and App) by following the

Chrome Setup Guide

3. Sign in with super admin email id of your Google Admin Conscle 1o sync GSuite
identities into Umbrella.

SUPER ADMIN SIGN IN

JSON File Example (Without VA):

Note: cannot contain line breaks or spaces

{"googleDirectoryService":{"Value":True},"organizationInfo":{"Value":{"organizationld":7896540,"regToke
n":" kBCTNrrRerVQep49ErsR1IAbLURODxKXn "}},"publicSession":{"Value":false},"valPs":{"Value":[]}}

VA customers only

To use the Cisco Umbrella Chromebook client in a network with Cisco Umbrella Virtual Appliances, you must add the IP
addresses of your VAs to the configuration file before uploading it. Each VA IP addresses must be enclosed in double quotes,

comma-separated. This example illustrates a network with two VAs:

"valPs":{"Value":["192.168.100.10","192.168.100.11"]}

JSON File Example (With VA):

Note : Cannot contain line breaks or spaces

{"googleDirectoryService":{"Value":True},"organizationInfo":{"Value":{"organizationld":7896540,"regToke
n":"kBCTNrrRerVQep49ErsR1IAbLURODxKXn"}},"publicSession":{"Value":false},"valPs":{"Value":["192.168.
100.10","192.168.100.11"]}}

Or
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{

"organizationinfo":{
"Value":{
"organizationld":1234567,
"regToken":"GtTYPQfgSzQtGzYUrINmbjgTu5XriDtn"
}
b

"valPs":{

"Value":[
"192.168.100.10",
"192.168.100.11"

]

h

"googleDirectoryService": {
"Value": true

}
}

Make sure you save the file in a known location. You will upload this file during the installation of the Cisco Umbrella

Chromebook client application.
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Part 2: Install the Cisco Umbrella Chromebook client extension

1. Loginto https://admin.google.com.

= (Google Admin Q. Search for users, groups, and settings (e.g. setup MX records)

Admin console

- i = " W

Users Company profile Billing Apps Support
A, rename, and Update informatian iew charges and Manage apps and thelr Talk with aur aupsort
manage Uears about your company manage licenses setlings team
o B .9,
Admin rales Domains Reparts Security Groups
Add new admins Aad domaing of domain Track usege nf services Manage secury Create proups and
nligses features rgiling lists

2. Select Devices.

[y

Devices

Secure corporate data
on devices

3. In the Device Management window, select Chrome Management.

DEVICE SETTINGS

Metworks

Chrome management
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4. Inthe Chrome Management window, select Apps & extensions.

Chrome Management

Devices

View and manage Chrome devices

Managed browsers

View and manage Chrome browsers

User & browser settings

Manage user-based settings on Chrome browsers and Chrome devices

Apps & extensions

Manage Android apps and Chrome apps and extensions

5. On the left side, select the OU of the Users you want to deploy the extension to, or the top level domain if
you want to push it to everyone.

Google Admin Q, Search for ug

Device management » Chrome » Apps & extensions

Search for organizational units

- | # 4+ Addafi
App

Allow users taii

Sl —
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6. Atthe bottom right, click the Yellow + then click the icon that resembles a calculator.

+ OEHO

7. Search for the ID of the Cisco Umbrella Chromebook client extension jedhmojfecjfmbdpchihbeilohgnbdci
then click save. (Searching by name will not work.)

Add Chrome app or extension by ID

Chrome apps and extensions can also be added by specifying the ID. If it is outside the
Chrome Web Store, you must also specify the URL where the extension is hosted.

Extension ID

icdhmojfecifmbdpchihbeilohgnbdci

From the Chrome Web Store -

CANCEL SAVE

8. Click on the drop down that currently says Allow Install

@ Cisco Umbrella Chromebook client (Ext) L Allow install >

& jcdhmaojfecjfmbdpchihbeiiohgnbdci Locally added

9. Select Force Install.
This ensures that Chromebook users in the selected Organization Unit cannot remove or disable the
extension.
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Installation policy

Force install + pin .
tensions

ops & extensions -
Force install efault

mebook client (Ext)  Allow install

linbeilchgnbdci
Block

10. Select Save.

You have finished installing the Cisco Umbrella Chromebook client extension. Next proceed with the next
section to install the Cisco Umbrella Chromebook client application.

» Apps & extensions

REVERT SAVE

WHAT'S NEW

USERS & BROWSERS

1D: “jedhmojfecjfmbdpchihbeilohgnbdci® €

CLEAR FILTERS

App Installation policy

Allow other apps & extensions from the CF

Allow users to install other apps & extensions

Inherited fr

@ Cisco Umbrella Chromebook client (Ext)  Force install
& jcdhmajfecifmbdpchihbeilohanbdei Locally added

Part 3: Install the Cisco Umbrella Chromebook client Application

m Google default

1. Loginto https://admin.google.com.
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Cisco Umbrella Chromehbook
client (Ext)

Cchrome Web Store options

Include in Chrome Web Store collection
Inherited from Google default

Permissions and URL access

Use default permissions for this organization


https://admin.google.com/

= (Google Admin ©,  search for users, groups, and setiings (e.g. setup MX records)

Admin console

- g = o &

Users Company profile Billing Apps Support
Add, rename, and Update information View charges and Mansge apps and their Talk with aur auppart
manage Uears about your company manage licenses setlings team

6] E. v » 2t

Admin rales Domains Reparts Security Groups
Add new admins Aad domaing of domain Track usege nf services Manage secury Create proups and
nligses features rgiling lists

2. Select Devices.

[y

Devices

Secure corporate data
on devices

3. Inthe Device Management window, select Chrome Management.

DEVICE SETTINGS

MNetworks

Chrome management

4. Inthe Chrome Management window, select Apps & extensions.
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Chrome Management

Devices

View and manage Chrome devices

Managed browsers

View and manage Chrome browsers

User & browser settings

Manage user-based settings on Chrome browsers and Chrome devices

Apps & extensions

Manage Android apps and Chrome apps and extensions

5. Onthe left side, select the OU of the Users you want to deploy the application to, or the top level domain if
you want to push it to everyone.

Google Admin Q, Search for ug

Device management » Chrome » Apps & extensions

Search for organizational units

- | # 4+ Addafi
App

Allow users taii

Sl —
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6. Atthe bottom right, click the Yellow + then click the icon that resembles a calculator.

+ OEHO

7. Search for the ID of the Cisco Umbrella Chromebook client application cpnjigmgeapagmdimmoenaghmhilodfg
then click Save.

(Searching by name will not work.)

Add Chrome app or extension by ID

Chrome apps and extensions can also be added by specifying the ID. If it is outside the
Chrome Web Store, you must also specify the URL where the extension is hosted.

cpnjigmgeapagmdimmoenaghmbhilodfg

From the Chrome Web Store -

CANCEL SAVE

8. Click on the drop down that currently says Allow Install

Cisco Umbrella Chromebook client (App) fLAllow install v

& cpnjigmgeapagmdimmoenaghmhilodig Locally added
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9. Select Force Install.

This ensures that Chromebook users in the selected Organization Unit cannot remove or disable the

extension.

Allru nthar anne & avtens
sions : ;
Force install + pin  efau

ant (app) J| Force install

lifodig
Allow install

Block

10. Paste the contents of the perviously saved json file in the Policy for extensions box

@ Cisco Umbrella Chromebook client (App) ~ Force install > Use default permissions for this organization ~
& cpnjigmgeapagmdimmoenaghmhilodfg Locally added

Inherited from Google default

Palicy for extensions

{"googleDirectoryService”:

{“VaIue":ﬁue},"organization Info":{"Value";
{"organizationld":2290882,'reqgToken""kBCTNrrRe

Qep8iad9EgAbLURDDxKXn "}, publicSession™
{"Value™false} valPs™{"Value["192.168.100.10",
"192.168.100.11"}}
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11. Select Save. You have finished installing the Cisco Umbrella Chromebook client Application

REVERT SAVE

WHAT'S NEW

ERS & BROWSERS KIOSKS AMAGED GUEST SESSIONS

0 Umbrella Chromebook -i- T3 %

ipagmdimmoenaghmhilodfg” & client (App)

Chrome Web Store options

instaliation palicy Include in Chrome Web Store collection
Inherited from Google default

Allow other apps & extensions from the C
all ather apps & extensions o
Inherited from Google default Permissions and URL access

RO e R L A U B Frrra inetall = e Vo

Installation Caveats

It can take Google four to eight hours to push the Cisco Umbrella Chromebook client to all of your Chromebooks. The

Chromebooks must be connected and logged in for the installation to take place.

After the client is installed in a Chromebook, allow a few hours for Chromebook traffic to begin to appear in your Umbrella

dashboard.

Apply Policies
To apply your policies to your organization's Chromebooks, see the Cisco Umbrella Chromebook Client Policy Configuration

Guide.

Make sure you have deployed the Cisco Umbrella Chromebook client before you configure policies. For more information, see

the Cisco Umbrella Chromebook Client Deployment Guide.

For general information about configuring policies in Cisco Umbrella, see Create and Apply Policies.

Overview
The overall process is to create a Chromebook-specific policy that will work together with your "network usage" policy that
applies to all devices connected to your networks. You place the Chromebook policy at the top of your policies list, so it will be
invoked first. This ensures that the Chromebook policy is applied to your Chromebooks. Then your network policy comes into

effect for all other devices connected to your network.

To maintain end-user privacy when Chromebooks are connected at remote locations, you can also disable Content Logging

and include only security-related events in your reporting.
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Create a Chromebook-specific policy

Follow these steps to create a policy to apply to all Chromebook users when connected to your network as well as outside of

your networks.

1. Navigate to Policies > Management > All Policies and click Add.
The Policy Wizard opens.

alvarfie i e L)
© ‘i All Policies ® ==

Sorted by Order of Enforcemant

~

Dafaut Policy Al Igertities 3 Policy Settings Nav 1, 2017

2. Select Chromebooks (some or all). Do not select any networks.

What would you like to protect?

Select Identities

Search Identities

! AD Computers
wn Networks
1 Roaming Computers

9 Sites

Expand to select specific

Netwark:Devices Chromebook users

7 Mabile Devices

& Chromebook User

& GSuite Users

All identities

3. Click Next.
Choose the content settings and security settings to apply to Chromebooks. A common practice is to enable
the default security settings and disable content filtering to maintain user privacy.

4. Expand Advanced Settings and turn off Enable Intelligent Proxy.

The Intelligent Proxy is not supported at this time.
Optionally, you can choose to log only Security Events to protect users' privacy.
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ApplyVDesﬂnatlon Lists
.ists of destinations that can be explici

ADVANCED SETTINGS

Enable Intelligent Proxy

0 web connections for risky domains.

SSL Decryption
Enabling SSL decryption allows the intelligent proxy to inspect traffic over HTTPS and block custom URLs in destination lists

Turning on SSL decryption allows HTTPS URL blocking.

Enable IP-Layer Enforcement
Gai reat

eats that bypass DNS lookups by tunneling suspect IP connections. Note: this is only available for Roaming

SAFESEARCH

O Enforce SafeSearch
Enforce Sz arch for queries sent to supported search engines Learn More

ALLOW-ONLY MODE

Allow-Only Mode

is mode, access to sites needs 10 be spe

cally granted; otherwise connections wi

LOGGING

@® Log All Requests

() Log Only Security Events
o¢ rt on only those rec

Log

() Don't Log Any Requests
Nor

Note

| be reported

inte

Click Next. Generally no changes are needed to the Security Settings.

Click Next. Similarly, Content Access settings often remain the same.

Click Next. Make any needed changes to the Application Settings.

Click Next. Make any needed changes to Destination Lists.

Click Next.

The Custom block page, Bypass Users, and Bypass Codes features on this page are not yet supported by the
Chromebook client.

LN W

Set Block Page

Setting

Define the a ance and s options for your block pages

@ Use Umbrella's Default Appearance
Preview Block Page »

() Use a Custom Appearance

. Choose an existing appearance v |

Currently unsupported

BYPASS USERS

BYPASS CODES

9. Click Next. Give your policy a name (the name is arbitrary), then click Save.
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Policy Summary

Paolicy Name

[ Chromebook Policy

[ 10!dentities Affected

10 Chromebook Users

Edit

.J Security Setting Applied: Default Settings
* Command and Control Callbacks, Malware, and Phishing
Attacks will be blocked
* No integration is enabled.
Edit Disable

'j Content Setting Applied: High
« Blocks adult-related sites, lllegal activity, soctal networking
sites, video sharing sites, and general time-wasters
Edit  Disable

* ADVANCED SETTINGS

U 2 Destination Lists Enforced

« 1 Block List
= 1 Allow List
Edit

E’ File Inspection Not Enabled

Reqguires intelligent Proxy

Umbrella Default Block Page Applied
Edit  Preview Block Page

CANCEL PREVIOUS

Your policy is automatically applied to Chromebooks. The process takes up to about 90 seconds.
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Arrange policies in order

Policies in Cisco Umbrella are applied in sequence from the top of the Policy List down. Make sure that your Chromebook
policy appears above your network usage policy. This ensures that your Chromebooks are protected by your Chromebook-

specific policy and all devices on your network (that are not Chromebooks) are protected by your Network Access policy.

Qﬁ Sorted by Order of Enforcement
. Applied To Contains Last Modfied v
Cheorsbock: Poficy 10 Identities 2 Policy Settings  Aug 28, 2018
N Kk A Paoli Appiied Ta Contains Last Modified ~
elwork Access Folicy 0 Identities 3 Policy Settings  Aug 28, 2018

Trusted Network Detection

The version of the Cisco Umbrella Chromebook client (UCC) released November 28, 2018 introduced trusted network
detection. Trusted network detection enables UCC to work with Umbrella virtual appliances (VAs) so that in a situation in
which a network can be trusted by the UCC because it is protected by Umbrella VAs (for example, in an on-premise network),

a Chromebook-specific policy can take precedence over the existing network policy.

How trusted network detection works

When the UCC detects a VA in a network, it sends the Chromebook user's identity to the VA and then deactivates. The VA

continues to handle DNS requests from Chromebooks by appending the users' identities to all requests to Umbrella resolvers.

When the UCC fails to detect a VA, the UCC directly sends DNS requests to Umbrella resolvers.

This update is reflected in the following architecture diagrams. First is the original UCC architecture.

INSIDE CHROMEBOOK
35 Q) g~
o —|
=03
Chrome Browser throme Chiome App umbrelia
Entension Laca 0K Servnr Racaluar

Auto register device
Autoregister device

Get Policies

|

[ : Apply Polickes
View Reparts R |//'

Manage Devices —_

Umbrelia Dashboard

The November 28 release means the UCC system is better represented this way.
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Internal Network

INSIDE CHROMEBOOK

IS

User

(B —E

Chrome Browser Chrome Chrome App

[Teacher/Shadent) Extenton Leeal ONS Server
i Post Identity
DNS Queries Fublic Queries
Umbrells
Resalver
Auto register device I
r—wl Get Policies
[ : Apply Folices S
View Reports —_— | /”'
Admin Manage Devices —_—

Important

Umbrella Dashbeard

In order to enable trusted network protection, both the Umbrella Chromebook client software and the Umbrella virtual

appliance software must be updated.

Software requirements

In order to enable trusted network detection, the following minimum software versions are required:

Umbrella Chromebook client extension 1.2.0
Umbrella Chromebook client app 1.2.5
Umbrella virtual appliance 2.3.2

80|Page


https://files.readme.io/23d4ba2-architecture-new.png

Deploy the G Suite Identity Service

The G Suite identity service feature is an enhancement to the Cisco Umbrella Chromebook client and adds the
Organizational Unit (OU)-based Umbrella policy enforcement capabilities. For overview information, refer

to Umbrella for G Suite Identity Service.

Enabling the G Suite Identity Service

Enabling the G Suite identity service for the Cisco Umbrella Chromebook client requires two steps:

o Install the Cisco Umbrella Authorizer marketplace app.
e Enter the G Suite account super administrator ID in the Cisco Umbrella dashboard.

Install the Cisco Umbrella Authorizer App

The Cisco Umbrella Authorizer marketplace application authorizes the scopes needed by Umbrella to retrieve
information from your G Suite account. Follow these steps to install the app in your Google administration console:

1. Open your G Suite administration console, using the super administrator ID.

2. Navigate to the app in the Google marketplace.

= GSuite Marketplace

Business Tools A " o DOMAININSTALL

Cisco Umbrella Authorizer
Accourting 4 Finaee:

Cisco Authonzation application for granting access to Cisco Umbeailz Cloud system
Adminstration & UNAVAILABLE FOR
Masagement Tk kk
ERP & Logistics
HR § Legai

( F - » g
Macksting & Analytice
Sales S CAM
- .~
-
...................
Productivity o
Create Tocls
Web Development
Office Apphcations < (R >
Task Management ==
—

Education A e
Academic Resources ——
Teacher & Admin Tools | —
Communication =
Utilities .

Overview
Recommended for Cisco Umbrella Authorization’ application for GSuite admins provides authorization for fetching identity information into
G Suite Cisco Umbrea Cloud system. Once authorized the customer can login into Cisco Umbrelia Cloud system 10 create user

and orgunit level security policies
Works with Google
Drive \

Reviews Engish  ~  Recent
Works with Gmail No comments
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3. Click Domain Install, then in the dialog that appears, click Accept
Google i}

e Cisco Umbrella Authorizer

You are granting Cisco Umbrella Authorizer the
right to access your domain data:

@ \iew domains related to your customers o

® View organization units on your domain o

@ View users an your domain 05§
Turn ON for :

=3 | agree lo the application's Terms of Servica, Privacy Policy
and G Suite Marketplace Terms of Service

-

Enter your G Suite super administrator ID in the Umbrella Dashboard
1. In Cisco Umbrella, navigate to Deployments > Chromebook Users.

2. Click Configure. The Configure Chromebook Umbrella Clients window appears.
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Configure Umbrella Chromebook Clients

Protecting Chromebook Computers

Enable Umbrella security for your Chromebooks by installing the
Chromebook client Extension and App. You configure the Umbrella
App by using the Google Admin Console to upload this data file

1. Download your organization's configuration file from the link below:

chromebookconfig.json ( Size ~0.7 kB )
2. Install the Chromebook client software (Extension and App) by
following the Chrome Setup Guide.

3. Sign in with super admin email id of your Google Admin Console to
sync GSuite identities into Umbrella.

SUPER ADMIN SIGN IN

3. Click Super Admin Sign In. In the window that appears, choose the super administrator account:
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® " ® Sign in - Google Accounts

® @ https://accounts.google.com/signin/oauth/oauthchooseaccount?c *s» & ¥

G Sign in with Google

&

Choose an account

to continue to Cisco Umbrella Authorizer
Q==
O s
(@) Use another account

To continue, Google will share your name, email address, language preference, and
profile picture with Cisco Umbrella Authorizer. Before using this app, you can review
Cisco Umbrella Authorizer's privacy policy and terms of service.

English (United States) ~ Help Privacy Terms

4. Signinto sync your G Suite identities with Cisco Umbrella. This can take up to 15 minutes.

The Umbrella Policies page displays two new containers: G Suite OUs and G Suite Users

REMEMBER! To add your G Suite OU’s and Users to the correct policy or they will get the bottom default policy!
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Removing Cisco Chromebook client software

To remove the software for a specific user:

1. Loginto your G Suite admin console, then click Users.

= Google Admin Q, Search for users, gro

Admin console

nm &
=B am
Dashboard Users
See relevant insights Add, rename, and

about your domain manage users

2. Choose a user, then choose More > Change Organizational Unit.

All organizations < 1 user selected X

@ Users from all organizational units Ny -+ Add a filter

O Users from selected organizational units
Name

__ Alexander TSEDemo

3. Click Change* to confirm your choice.
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User move confirmation

Alexander TSEDemo
Please review the following that applies to the DemoOrg
organization

=s  Some services may not be turned ON
The users will not be able to use the services that are not

turned ON

2 Some service level settings may change for the selected

A

users

Are you sure you want 1o move Alexander 1o DemoOrg?

0 This change may take up to 24 hours to take effect

CANCEL J CHANGE

You have finished removing the Chromebook client for that user.

To remove the software for all members of an Organizational Unit (OU):
1. Follow the instructions for Installing the Cisco Umbrella Chromebook client extension.

2. Select the OU you wish to remove the extention from, then select Cisco Umbrella Chromebook client (Ext)
3. Click the trash icon to remove the extension, then click SAVE

REVERT [ SAVE |

s & extensions WHAT'S NEW

USERS & BROWSERS KIDSKS MANAGED GUEST SESSIONS

< 3
e —_— Cisco Umbrella Chromehook
- + Search or add a filter client (Ex0) E M X

App Installation policy Chrome Web Stare options

eh Store collection
Allow other apps & extensions from the C
Allow users fo install other apps & extensions
Inherited from Gooagle default

@ Cisco Umbrella Chromebook client (App) ~ Force install Permissions and URL access

& cpnjigmgeapagmdimmoenaghmhiledig Locally added
Use default permissions for this organization

@ Cisco Umbrella Chromebook client (Ext) ~ Force install v
& icdnmoifecifmbdpchihbailohgnbdel Locally added S host
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Roaming Client Setup
Windows/Mac OS

If you have Windows or MacOS devices that you would like to protect when they go offsite then you can
download the roaming client for them. Navigate to Deployments->Roaming Computers and click on the
Roaming Client download icon in the top right-hand corner. Then, download and install the client that
pertains to that OS.

Download Roaming Client

The roaming client grotects laptops and deskiops, on and off the network. Before
instaling the roaming client, read through the documentation and prerequisites.

For your internal domains to resolve; you must add them to the intemal domains
ist. It's important to add them before you deploy!

Clsco Umbrslla Roaming Client

Download Windows Client

Suppored Versions: Windows Vista, 7,8, 10

Download macOS Client

Supponsd Versions: mac0S 10,11+

For more documentation and prerequisites please click here.

i0S Mobile Security- iPads in Umbrella

The Cisco Security Connector—Umbrella Setup Guide only explains how to configure the Umbrella portion of the Cisco Security
Connector (CSC). For information about how to configure your Mobile Device Manager (MDM) system, see your MDM
system’s documentation.

The Cisco Security Connector provides visibility and control for organization-owned and MDM managed mobile Apple iOS
devices, such as iPhones and iPads. The CSC's Umbrella component directs DNS traffic, including functionality for the
intelligent proxy, to the Cisco Umbrella cloud where filtering against malicious sites, such as phishing sites or sites that

exfiltrate information, takes place.

The CSC’s Umbrella portion does not require an on-demand or always-on VPN or a full proxy to gain complete visibility and
control through cloud security (not locally on the device). This makes for both easier management and simpler, more effective

security.
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Note: Your iOS mobile device must be supervised and managed by an MDM system.

For more information about the Cisco Security Connector, see Cisco Security Connector (CSC).

Requirements

For the Cisco Security Connector:

e iOS device running iOS version 13.2 or higher.
e YouriOS device must be running in supervised mode.

e YouriOS device must be managed using a Mobile Device Manager (MDM) system and Apple School Manager or Apple

Business Manager.

Five MB free space.

One of the following supported MDM systems:

Meraki System Manager (SM) with APl access enabled.

Note: Only System Manager and Combined network types are supported.
e Apple Configurator 2.5 or higher.
e IBM MaaS360.
e Intune.
e Jamf.
e MobiConnect
e Mobilelron Enterprise Mobility Management (EMM) On-Prem and Cloud versions 9.4 or higher.
e  Workspace ONE.

e Generic— MOSYLE - Other MDMs may be used to manage your organization-owned iOS mobile device; however, success

results may vary. For more information, see Register an iOS Device through a Generic MDM System.

For information about configuring your specific MDM system, see your MDM system’s documentation or contact your MDM's

support team.

You will also need:

e Cisco Umbrella account.
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Direct access to the IPv4 IP addresses 208.67.222.222 or 208.67.220.220 is required for IPv4 DNS protection on ports 53
and 443,

Direct access to the IPv6 IP addresses 2620:119:35::35 or 2620:119:53::53, or access to IPv4 addresses on ports 53 and 443
through NAT64/DNS64 translation is required for IPv6 DNS protection.

Note: If DNS protection fails to engage, DNS traffic is not encrypted.

The device must be able to communicate with registration.polaris.qq.opendns.com for registration and validation

purposes at least once a day—when actively used—otherwise, the device cannot be protected.

Depending on the MDM, you may also require each device's serial number.

1. Install the Cisco Security Connector App

1. OnyouriOS device, download and install the Cisco Security Connector app.
Get the Cisco Security Connector app from the App store. Depending on your MDM, you may be able to deploy the Cisco

Security Connector to supervised iOS mobile devices through your MDM.

Cisco Security Connector

Y

Protection anywhere,
anytime

Praviding deeper visibiity and control for

enterprisa-owned devicas

Lesm More
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2. Add an Organization Administrator’s Email Address

This is the email address that your end-user can use to send diagnostic reports from the app by clicking the I icon from within

the iOS device. These reports can then be passed onto Cisco support. Once set, this email address is automatically added

when managing an MDM.

1. Navigate to Deployments > Core Identities > Mobile Devices and click Settings.

Deployments [ Core Identities
)]

asco Mobile Devices Settings

772N
()
=/

Manage MDMs

2. In Mobile Device Settings, add an email address, select a notifications level, choose a device identification method, and

click Save.

Mobile Device Settings

Organization Administrator’s Email Address
This email is for end users o generate problem reports within the Cisco Security
Connector app and send these reports to the administrator.

email@admin.com

User Notifications
Adjust level of notifications shown to users on their device

© None
Notify on Protection Failure
Notify on Protection Change

Device Identification
Choose whether to display device name or anonymize with serial number only.

Full Identification v

[enea | IEZN

3. Register Your iOS Device Through Your MDM to Umbrella

1. In Umbrella, navigate to Deployments > Core Identities > Mobile Devices and click Manage MDM:s.

asco . Mobile Devices i

Deployments | Core identities y
|‘l\7{:}/o
Settings

7o
{ \
| gé )
\ /
R A

Manag; MDMs

2. Click the appropriate MDM.
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Manage MDMs
s or manage devioes using the MDM of your choice

Cisco Meraki

- Link MOM

’

Appie

1BM Maas360
T MAXS300 32
Dewriioad MobleCanfig

Microsoft intune
B2 Microsoft

Dowricad MobieContig

2 jamf —

Dowrrosd MobleContig

Dowricad MobleCanfig

Mobileiron
@ rotueron
Dowriosd ModleContig

C’ Workspace ONE

Dowrraad MobieCantig

Den’t see your MOMT
You can download our generic motifecontiy fle and fink the MDM manualy.

4. When you have successfully registered your iOS device, Umbrella lists it at Deployments > Core Identities > Manage

MDMs.
Deployments / Core Icentities
atfean) s : - L
cisce MOblIe DeVICeS Settings Manage MDMs
Label Serial Number Last Sync OS Version App Version Mdm
wWJC C8PVV3JWJCE 2018 i0S 11.2 0.0.0 S

5. Onyour mobile device, in the Cisco Security Connector app, tap the Status icon and confirm that it shows Protected by

Umbrella. For protection details, tap Protected by Umbrella.
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DETAILS
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2 o o -

Jamf

By downloading an XML file from Umbrella, optionally updating it, and then pasting part of its contents into your Jamf system,
Jamf is able to push configuration information to both the Cisco Security Connector (CSC) and Umbrella so that your iOS

device is registered with Umbrella. The result is that your iOS device is protected by Umbrella.

For information about configuring Jamf, see Jamf's documentation.
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Anonymization

Umbrella provides you with the option of anonymizing mobile devices for reporting and administration purposes. When you
anonymize a mobile device, its label is hidden and replaced by your device's serial number. The label name is anonymized in
both the Umbrella dashboard and in the CSC app Ul. For information about how to anonymize your device, see Anonymize

Devices.

Prerequisites

e Jamf Pro 10.2.0 or higher.

e You must first configure your Jamf MDM system. Configure Jamf as required so that it is able to push configuration
information to both CSC and Umbrella. For information about configuring Jamf, see Jamf documentation. For support,

contact Jamf support.
e The Cisco Security Connector app is installed on your iOS device.
e iOS device running iOS version 13.2 or higher.

e YouriOS device must be running in supervised mode.

e YouriOS device must be managed by Jamf and Apple School Manager or Apple Business Manager.

e You have added an administrator email address.

This address is used by CSC to send you diagnostic reports that you can pass on to Cisco support as needed.
e You'll need the serial number for each iOS device to be registered with Umbrella.
e Cisco Umbrella account.

e Direct access to the IPv4 IP addresses 208.67.222.222 or 208.67.220.220 is required for IPv4 DNS protection on ports 53
and 443.

e Direct access to the IPv6 IP addresses 2620:119:35::35 or 2620:119:53::53, or access to IPv4 addresses on ports 53 and 443
through NAT64/DNS64 translation is required for IPv6 DNS protection.

Note: If DNS protection fails to engage, DNS traffic is not encrypted.

e If anonymizing devices, Mobile Device Settings are updated to By Serial Number Only. For more information

see, Anonymize Devices.

e YouriOS device must be able to communicate with .opendns.com for registration and validation purposes at least once a

day.
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Regqister Your iOS Device

Note: You must log into your Umbrella dashboard as an administrator.

1. In Umbrella, navigate to Deployments > Core Identities > Mobile Devices and click Manage MDMs.

‘ il Deployments / Core identities (- a\u
4 A \ /
i Mobile Devices Setings

2. Under Jamf, click Download MobileConfig.
Manage MDOMs

At or manage devices using the MOM of your chosce.

; Cisco Meraki
Link MOM
S Apple
‘ Downlpad MobileConfig
IEM Maas 360

B S0 =
Download MobileConfig

Microsoft Intuna

B% Microsoft
Downbopd MobileConfig

A jamf i

Downiond MobileConfig

™S

3. Add an email address to generate problem reports and click Download.

."/‘\\
(&)
.
Manage MDMs

This email address is where diagnostic reports are sent when a user clicks the I icon from within the iOS device. Once set,

this email address is automatically added when managing an MDM.
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Download Jamf Mobileconfig

Organization Administrator’s Email Address

admin@example.com

4. Copy and paste the XML code between the <!-- Jamf... --> comments into your MDM profile.

XML

1 | N
<?xml version="1.0" encoding="UTF-8"7>
<IDOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://www.apple.com/DTDs/PropertyList-

1.0.dtd">
<plist version="1.0">

<dict>
<key>PayloadContent</key>
<array>
<!-- Jamf - copy from here to paste into the Jamf UI to provision a DNS proxy -->
<dict>
</dict>
<!-- Jamf - end copy -->

5. Inyour new profile, applied for the CSC group, choose Custom Settings and then Configure. Paste the edited XML here.
If successful, your mobile device registers with Umbrella and is listed at Deployments > Core Identities > Sylvia Massy. CSC

on your mobile device updates to connect to Umbrella so that your iOS device is protected by Umbrella.

6. Example of what is put into the Config Profile in Jamf from the downloaded jamf.xml file obtained from Umbrella: (your

organization id string and regToken will be different)
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<?xml version="1.0" encoding="UTF-8"7>
<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "“http://www.apple.com/DTDs/
PropertyList-1.0.dtd">
<plist version="1.0">
<dict>
<key>PayloadContent</key>
<array>
<dict>
<key>AppBundleldentifier</key>
<string>com,ciscQ.ciscosecurity, app</string>
<key>PayloadDescription</key>
<string>Cisco Umbrella</string>
<key>PayloadDisplayName</key>
<string>Cisco Umbrella</string>
<key>PayloadIdentifier</key>

<key>PayloadType</key>
<string>com.apple.dnsProxy.managed</string>
<key>PayloadUUID</key>
<string>E5D191FD-6E@1-4733-9720~E27BFBCB8DC5</string>
<key>PayloadVersion</key>
<integer>l</integer>
<key>ProviderBundleldentifier</key>
<string>com.cisco, ciscosacurity.app.Ciscoumbrella</string>
<key>ProviderConfiguration</key>

<!== Jamf - copy from here to paste into the Jamf UI to provision a DNS proxy =->
<dict>

<key>anopymizationltevel</key>
<integer>@</integer>

9% |Page



New Mobile Device Configuration Profile
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PROVIDER CONFIGURATION XML Ver

er specific configuration vaiues

i] Fant <dict>
Mot Configurad <kay=ananymizationlevelkey>
<integer=0<finteger>
“key=disabled=/key>
AirPla e
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R <aArray>
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: =string=18 172, drarpas/string=
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Upload Provider Configuration XL
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Mosyle

1. Download the Cisco Security Connector from the Apple Volume Purchase Program

Volume Purchase Program
Search Media Type Category
(Q cisco umbrella 10S Apps V| |All v Search

Purchase Details

1 Price Quantity
© Cisco Security Connector Free 10S App
by Cisco
20
Managed Distribution Free apps are only available in bulk using managed distribution. Assign apps by using a Mobile Device Management (MDM) solution,
such as the {atest version of Apple Profile Manager. You retain ownership of apps only, allowing you to reveke and reassign them as needed

2. Push out the Cisco Security Connector App with Mosyle.
3. Download the Generic Mobileconfig file.

Example:

4. In Mosyle, navigate to DNS Proxy Extension and enter the following:
e Name — Cisco Umbrella
e App Bundle Id — com.cisco.ciscosecurity.app
e Provider Bundle ID - com.cisco.ciscosecurity.app.CiscoUmbrella

e Provider Configuration — everything in the generic mobile config file.xml from
<dict>
<key>anonymizationLevel</key>
<integer>0</integer>
<key>disabled</key>
<false/>

<key>serialNumber</key>
<string>{SERIAL_NUMBER}</string>
</dict>

e Replace SERIAL_NUMBER with %SERIALNUMBER%
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5. Assign it to the students/staff/devices you want and push out those settings in Mosyle.
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Deployments | Core Icentities () 2\
e POy 7 e '.‘iii',' '.,@91,'

cisco MObIle De\/|CeS Seit_ir'\gs Manat_;;MDMS

Label Serial Number Last Sync OS Version App Version Mdm

wWJC C8PVV3JWJICE 2018 i0s 11

~N

0.0.0 e

If you have anonymized your device (see Anonymize Devices), Umbrella hides the device's true label name by replacing it with

the device's serial number. Existing active devices anonymize with 24 hours. New devices anonymize immediately.

alia]y, Deloyments / Core icentities [:{}:} (':09:)

GIAER MObIle DeV|CeS Setr._ings Managé MDMs
Label Serlal Number Last Sync OS Version App Version Mdm
C8PVV3JWJC6 C8PVV3JWJICE 2018 i0S11.2 0.0.0 Saiaa

As no changes can be made in Umbrella to the actual provisioned device, these mobile devices are simply listed in Umbrella as
identities; however, you can now use Umbrella to apply policies to these mobile device identities. For more information,

see Apply Umbrella Policies.

Android Mobile Security

Umbrella has just recently released feature. If you would like to try it, please see the latest documentation here.

Adding an additional Fixed/Static Network
(MiFi/Jetpack)

Step 1 — Obtain a static IP/range from your ISP

First, determine the IP address of your network.
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2. InUmbrella, navigate to Deployments > Core Identities > Networks.

You'll find your IP address listed at the top of the page. If you don't see your IP address, click the i (Information) icon.

Deployments [/ Core Igentities
aleatfs ;

casco  Networks e

A network may be a single public IP address (static or dynamic) or a range of public IP addresses, depending on the size of your

network. Add a network to Umbrella to extend protection to any device that connects to the internet from behind that network's IP
space. The public IP of your network isjXXX. XX. XXX. XX

Pre-registering Your Networks

©

Add

If you plan to have multiple network identities, it's a good idea to immediately register all of your networks with Umbrella.

Chances are that if you have more than one public egress IP in your organization, you'll have more than one network identity.

Having the networks pre-registered ensures that they're available right away when you do point traffic. It also ensures that all

the IP space that belongs to your company is correctly assigned in our systems. Until traffic is pointed to Umbrella's DNS

service, no protection is available and there is no reporting so there's no harm in adding all networks beforehand.

Step 2 — Set up the Network Identity

.Navigate to Deployments > Core Identities > Networks and click Add.

Cisco Umbrella

_' Dy R
elnformatlon Networks @

Core Identities | & Search with a network name or IP address

Advanced

Networks

Name IP Address
Network Devices A

Roaming Computers DIS-Public

& Active

Note: If possible, add the network from the IP being registered; otherwise, an email is generated, which requires that a link is

visited from the IP address of the network being registered.

2. Inthe Add a New Network modal, give your network identity a meaningful Network Name.

Giving your identity a good network name will help you find it easily when you later add a policy against it through

the Policy wizard.

101|Page



https://docs.umbrella.com/deployment-umbrella/docs/create-and-apply-policies
https://files.readme.io/dbcc573-locate_IP_address.jpg
https://files.readme.io/62a71e5-core_identity_network.jpg

Add a new network
Start by pointing your network's DNS to our servers:

IPv4: 208.67.220.220 and 208.67.222.222
IPv6: 2620:119:35::35 and 2620:119:53::53

Network Name
@ 1Pv4 only O IPv6 only Q Mixed IPv4 & IPv6
IPv4 Address

0.0.0.0 / |32 v

(J) This network has a dynamic IP eddress. Leam More »

3. Select an internet protocol—IPv4, IPv6, or both.

Select a protocol based on the Umbrella IP address to which you have configured your router.

4. Add the network's IP address along with the subnet mask, usually a /32 subnet for IPv4 and /64 subnet for IPv6.

5. Click Save.
Once the service validates your IP address, the network is listed at Deployments > Core Identities > Networks. Initially,
Umbrella lists your new network identity's status as Inactive. Network status only changes to Active when DNS traffic is
sent to Umbrella from the network.
The policy applied to your new identity depends on your policy configurations. If you have a policy configured that includes

network identities, Umbrella applies that policy; otherwise; Umbrella applies the Default policy.

Name IP Address Dynamic Primary Policy Status

Network Identity One 12.12.12.2 Default Policy & Inactive
~

Name IP Address Dynamic Primary Policy Status

Network Identity One 12.12.12.2 Default Policy & Active
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Step 3 — Change the DNS Settings on Your Relevant Network Device

You need only do this on your edge DNS equipment, typically a DNS or DHCP server, or a router—this could be your DSL router

or cable modem if that's the only router in your network. Change DNS to 208.67.222.222 and 208.67.220.220

Example for Verizon Orbic Hotspot:

103|Page



RSD VZ Hotspot Orbic

Hame . RS0 V2 Hotzpot Orbic Savo Export Cancel Delate
Fiekds marked with an asterisk® are optional I left empty o sebection i "Not Managed”, the existing vakue on the device will be used,

Wi-Fi

Security

Advanced

Mac Filter
MAL Fiifer Enabled Hp W
Ackd Liser's Device's Wi-Fi MAC Addresses

Ackd WiHFI MAG Addresses for Malching User Property

White Listed MAC Address

Blocked MAC Address
Maramal DNS Enabled Yoz w
Manual DMNS Address 1 | 20867222222
Manual DNS Address 2 | F0RET X020
RFC1918 Privale IF Address Ranges Chsabled =

&nﬂ;ﬂadﬁ Addrass Ranges included /

Login to Umbrella with the laptop or device that is connected to the MiFi you are setting up and click on Verify from that
device:
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2, Search with a neiwork name or IP address  Advanced

Name & IP Addraes Dynamic Primary Policy Srmtus
DiS-Public Default Policy & Active
A Verifying
VZ-MIFi-63.46.50. 221 Default Policy
VERIFY

Step 4 — Test Your Network after it’s verified and active

Verify that your DNS connections are routed through Cisco Umbrella's global network by navigating to the following page in
your client's browser: https://welcome.umbrella.com/. You should see the Welcome to Umbrella page.

Note: You may need to restart your client's network interface or your computer.

To test your security settings, navigate to http://examplemalwaredomain.com/.

Support  ConiactUs  Login

CIsco C|SCO Umbre“a Product Customers Use Cases Partners Resources Blog Q

Q Welcome to Umbrellal

Your internet is faster, more reliable and better
protected because you’re using Cisco Umbrella.
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Appendex:

Application Category Descriptions

e Ad Publishing—Applications that enable publishers and ad networks to manage ad serving and trafficking.
e Anonymizer—Services that provide an anonymous proxy tool that attempts to make activity on the Internet untraceable.

e Application Development and Testing—Applications suited for application development and testing cycles, or for building

integration applications in the cloud and within the enterprise.

e Backup and Recovery—Applications for backup and recovery of file systems and raw data stores on servers and desktop

systems.

e Business Intelligence—Applications for analytics such as dashboards, reporting systems, scenario modeling, and data

analysis.

e Cloud Broker—Applications that manage the use, performance, and delivery of cloud services and negotiate relationships

between cloud providers and cloud consumers.

e Cloud Carrier—Intermediary that provides connectivity and transport of cloud services between cloud consumers and

cloud providers through a network, telecommunication, and other access devices.

e Cloud Service Provider—Based on NIST definition of a cloud service, which we believe is being (slowly) adopted as the
industry standard. The NIST definition includes the following criteria: "on-demand self-service, rapid elasticity, and
measured service. CASI additionally adds vendor intent to provide computing-related services (Compute, Network, Storage
and/or Software Application). If in doubt whether web or cloud, we will be conservative and assume cloud until we can

prove otherwise.

e Cloud Storage—Applications that offer massively scalable storage capacity that can be used for applications, and file

storage.

e Collaboration—Applications that enhance communication and collaboration in workgroups, within enterprises, and across

enterprises.

e Compute—Fundamental computing resources for running cloud-based systems that can be dynamically provisioned and

configured as needed.

e Content Delivery Network (CDN)—Applications that store content and files to improve the performance and cost of
delivering content for web-based systems by offering a large distributed system of servers deployed in multiple data

centers across the Internet.
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e Content Management—Applications for managing the production of and access to content, enforcing document

production workflows, and providing workspaces for groups or enterprises to find and access documents.

e Customer Relationship Management (CRM)—Applications that manage interactions with current and future customers,

including organization and automation across sales, marketing, and customer service functions.

e Database Management—Applications offering scalable data management solutions for structured or unstructured data,

relational database solutions or scalable non-SQL datastores.
e E-Commerce—Applications that facilitate the buying and selling of products or services.

e Education—Applications that provide educational or training courses, general learning opportunities or specific employee

training independent of their location.

e Enterprise Resource Planning (ERP)—Applications that manage operations or management of a business; which can

include internal and external resources, including tangible assets, financial resources, materials, and human resources.
¢ Financial Services—Applications for managing financial processes and information.
e Games—Online and mobile games.
e Healthcare—Healthcare related apps and services.

e Hosting Services—Applications that enable corporate or individual websites or other content to be accessible over the

internet.
e Human Resources—Applications for managing human resources and HR functions.
e IT Service Management—Applications that support specific IT functions to plan, deliver, operate and control IT services.
e Legal—Applications that provide access to legal documents and public records and support legal content.
e Marketing & Sales—Applications that are specifically designed for marketing and sales functions.
e Media—Applications that host or stream media as a service.

e  Office Productivity—Applications for producing information and other standard office-oriented tasks such as

documentation, presentations, project management, etc.
e Others—Used for those services where no existing categorization would fit.
e P2P—Peer to Peer torrents like apps and protocols.

e Search—Web or app-based search.
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e Security—Applications that support security activities to ensure adherence to regulatory compliance rules and protect

information, data applications, and infrastructure.
e Service Management—Applications that support general operational activities outside of the IT function.
e Shopping—Web or app-based basic online shopping.

e Social Networking—Applications that establish and maintain a connection among users that are tied in one or more

specific types of interdependency.
e Software Repository—Software repositories.
e Travel—Travel-related apps and services.

e Web Content—Mostly app-based services that provide content. It can be via login and/or paid portal.

Content Category Descriptions

e Academic Fraud—Sites that promote educational fraud, including but not limited to plagiarism and cheating.
e Adult:

e  Adult Themes—Sites that are adult in nature and are not defined in other rating categories.

Note: Select this category only if you want to be very restrictive on your network.

e Sexuality—Sites that provide information, images or implications of bondage, sadism, masochism, fetish, beating, body
piercing or self-mutilation. This category is not intended for LGBT-related sites that do not fall under the

aforementioned criteria.

e Alcohol—Sites about alcohol use, commercial and otherwise.

e Arts—Galleries and exhibitions; artists and art; photography; literature and books; performing arts and theater; musicals;

ballet; museums; design; architecture. Does not include movies or television.
e Astrology—Astrology; horoscope; fortune-telling; numerology; psychic advice; tarot.
e Auctions:

e Auctions—Sites for buying and selling through an auction.

e Classifieds—Sites for buying and selling (or bartering) goods and services. Includes sites with real estate and housing

listings.
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e Automotive—Sites about automobiles, including manufacturers, news, reviews, and hobbyist information.

e Business Services—Sites for corporations and businesses of all sizes, especially company websites.

e Chat:

e Chat—Sites where you can chat in real-time with groups of people. Includes IRC and video chat sites.
e Instant Messaging—Sites that offer access or software to communicate in real-time with other individuals.

e Child Abuse Content (CAC)—Sites that contain child sexual abuse content. For more information, see the Internet

Watch Foundation.

e Computer Security—Offering security products and services for corporate and home users.

e Dating—Sites for meeting other people.
o Digital Postcards—Dating, online personals, matrimonial agencies.

e Dining and Drinking—Eating and drinking establishments; restaurants, bars, taverns, and pubs; restaurant guides and

reviews.

e DIY Projects—Guidance and information to create, improve, modify, decorate and repair something without the aid of

experts or professionals.
e Drugs—Sites about illegal or recreational drug use.

¢ Dynamic and Residential —IP addresses of broadband links that usually indicate users attempting to access their home

network, for example for a remote session to a home computer.
e Ecommerce/Shopping—Sites that are online stores for products and services.
e Educational Institutions—Sites for schools, covering all age levels and types.
e Entertainment:

e Anime/Manga/Webcomic—Sites that host online comics, cartoons, and graphic novels.

e Fashion—Clothing and fashion; hair salons; cosmetics; accessories; jewelry; perfume; pictures and text relating to body

modification; tattoos and piercing; modeling agencies. Dermatological products are classified as Health and Nutrition.
o File Storage—Sites that offer space for hosting, sharing and backup of digital files.

e File Transfer Services—File transfer services with the primary purpose of providing download services and hosted file

sharing.

¢ Financial Institutions—Sites for banks, brokerages, trusts, and other financial organizations.
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e Freeware and Shareware—Providing downloads of free and shareware software.
e Gambling—Sites that offer gambling or information about gambling.
e Games—Sites that offer gameplay and information about games (news, tips, cheat codes).

e German Youth Protection—Content deemed harmful to minors. This category helps prevent viewing of youth-
endangering content in Germany. Block pages for this category will include German text. This list is not controlled by
Umbrella and is created to be controlled by the BPjM (Federal Review Board for Media Harmful to Minors) to be compliant
with German Law. For more information, see General Information.

Note: We do not guarantee compliance with German law.

e Government—Sites operated by government agencies, including city, state, regional, county and federal levels. Also

includes .mil domains.
e Hacking—NDiscussing ways to bypass the security of websites, software, and computers.

e Hate/Discrimination—Sites that promote intolerance based on gender, age, race, nationality, religion, sexual orientation

or other group identities.

e Health and Fitness—Sites that offer information about health care and health services. Includes fitness related sites and

information about health and fitness.
e Humor—Sites that are intended to be funny or humorous.
e Hunting—Professional or sports hunting, gun clubs, and other hunting-related sites.
e lllegal Activities:

o lllegal Activities—Promoting crime, such as stealing, fraud, illegally accessing telephone networks; computer viruses;

terrorism, bombs, and anarchy; websites depicting murder and suicide as well as explaining ways to commit them.

e Terrorism—Sites that promote terrorism or are linked with terrorist organizations.

e lllegal Downloads—Providing the ability to download software or other materials, serial numbers, key generators, and

tools for bypassing software protection in violation of copyright agreements. Torrents are classified as Peer File Transfer.
e Infrastructure:
e URL Shortener—An online application or service that converts a regular URL into a condensed format.

e Infrastructure—Content delivery infrastructure and dynamically generated content; websites that cannot be classified

more specifically because they are secured or otherwise difficult to classify.
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Internet Telephony—Telephonic services using the internet.

IT-ADM—Sites that offer gambling or information about gambling and tobacco. For more information, see the Italian

Nacional Agency.

IT-AGCOM—Sites that are deemed to infringe on intellectual property. For more information, see the Italian National

Agency.

Jobs/Employment—Sites that offer job listings, resume services, interview coaching, and similar employment-related

services.

Lingerie/Bikini—Sites displaying or dedicated to lingerie/bikini that could be considered adult-only.
Lotteries—Sweepstakes, contests, and state-sponsored lotteries.

Military—Miilitary, such as the armed forces, military bases, military organizations, anti-terrorism.

Mobile Phones—Short Message Services (SMS); ringtones and mobile phone downloads. Cellular carrier websites are

included in the Business and Industry category.

Nature—Natural resources; ecology and conservation; forests; wilderness; plants; flowers; forest conservation; forest,
wilderness, and forestry practices; forest management (reforestation, forest protection, conservation, harvesting, forest
health, thinning, and prescribed burning); agricultural practices (agriculture, gardening, horticulture, landscaping, planting,
weed control, irrigation, pruning, and harvesting); pollution issues (air quality, hazardous waste, pollution prevention,
recycling, waste management, water quality, and the environmental cleanup industry); animals, pets, livestock, and

zoology; biology; botany.

News/Media—Sites that offer news and information, including newspapers, broadcasters, and other publishers.
Non-Profits—Sites for non-profit or charity organizations and services.

Nudity—Sites that provide images or representations of nudity.

Online Communities:

e Blogs—Personal Sites or group journals, diaries or publications.

e Forums/Message Boards—Sites with discussions, including bulletin boards, message boards, and forums.

Online Meetings—Online meetings, desktop sharing, remote access, and other tools that facilitate multi-location

collaboration.

Online Trading—Online brokerages; websites that enable the user to trade stocks online; information relating to the stock

market, stocks, bonds, mutual funds, brokers, stock analysis and commentary, stock screens, stock charts, IPOs, stock
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splits. Services for spread betting on stocks and shares are classified as Gambling. Other financial services are classified as

Finance.
Organizational Email—Websites used to access business email (often through Outlook Web Access).

P2P/File Sharing—Sites that facilitate the sharing of digital files between individuals, especially through peer-to-peer

software, including torrent sites.
Paranormal—UFOs, ghosts, cryptid, telekinesis, urban legends, and myths.

Parked Domains—Sites that are placeholders "parked" for future use. Current uses may include single-page advertising

sites.

Personal Sites—Websites about and from private individuals; personal homepage servers; websites with personal

contents; personal blogs with no particular theme.

Personal VPN—Virtual private network (VPN) sites or tools that are typically for personal use and may or may not be

approved for corporate usage.
Photo Search and Images:
e Visual Search Engines—Sites for searching for images based on keywords.

e Photo Sharing—Sites for sharing photographs, as individual images, galleries, and albums.

Politics—Sites about politics, politicians, political parties and organizations. Government sites are separate.
Pornography—Anything relating to pornography, including mild depiction, soft pornography or hard-core pornography.
Professional Networking—Social networking for career or professional development. See also Social Networking.

Proxy/Anonymizer—Sites providing proxy bypass information or services. Also, sites that allow the user to surf the net

anonymously, including sites that allow the user to send anonymous emails.

Real Estate—Information that would support the search for real estate; office and commercial space; real estate listings,

such as rentals, apartments, and homes; house building.

Religious—Sites about religion, religious teachings and groups, and spirituality.
Research/Reference—Sites such as encyclopedias, dictionaries as well as other research-related resources.
SaaS and B2B—Web portals for online business services; online meetings.

Safe for Kids—Directed at, and specifically for, young children.
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Science and Technology—Science and technology, such as aerospace, electronics, engineering, mathematics, and other
similar subjects; space exploration; meteorology; geography; environment; energy (fossil, nuclear, renewable);

communications (telephones, telecommunications).
Search Engines and Portals:
e Search Engines—Sites that offer result listings based on keywords.

e Portals—Sites that offer gateways to the Internet as a whole, often including bundled services on their site.

Sex Education—Factual websites dealing with sex; sexual health; contraception; pregnancy.

Social Networking—Sites that promote interaction and networking between people.

Social Science—Sciences and history related to society; archaeology; anthropology; cultural studies; history; linguistics;

geography; philosophy; psychology; women's studies.
Society and Culture—Family and relationships; ethnicity; social organizations; genealogy; seniors; child-care.

Software/Technology—Sites about computing, hardware, and technology, including news, information, code and vendor

information.
Software Updates—Websites that host updates for software packages.

Sports—Sites about sports of all kinds, from professional to amateur, from news to league information and schedules.

Includes martial arts and MMA related sites.

Streaming Audio:

e  Music—Sites about music, including news, band and fan information.

e Radio—Sites that offer online radio listening or promote radio stations.

e Podcasts—Sites that offer podcasts, digital media files distributed over the Internet, often using syndication feeds, for

playback on portable media players and personal computers. Both audio and video podcasts are included.

Streaming Video:

e Movies—Sites that promote movies or offer movie watching online.

e Video Sharing—Sites for sharing video content.
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e Tasteless—Sites that contain information on such subjects as mutilation, torture, horror, or the grotesque. Includes pro-

anorexia and pro-suicide related sites.

e Television—Sites that promote television shows or offer television watching online.

e Tobacco—Sites about tobacco use and related products, commercial and otherwise.

e Travel—Sites with travel information and services, including reservations for airlines, cars, hotels, vacations, and trips.
e Weapons—Sites about weapons, commercial and otherwise.

e Web Hosting—Website hosting; bandwidth services.

e Web Page Translation—Translation of web pages between languages.

e  Webmail—Sites that offer the ability to send or receive email.
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Troubleshooting

What Policy is being applied?

Windows or Mac

The first step is to collect the debug output from the client machine that you wish to determine the
applied policy for. Debug output can be gathered by running the following commands from a command
prompt on Windows, or a Terminal window on OS X:

nslookup -g=txt debug.opendns.com

The output should look similar to this:

c:\>nslookup —g=txt debug.opendns.
Server: resolverl.opendns.com
Address: 208.67.222.222

Non—authoritative answer:
debug.opendns.com text

"server 3J.pao
-opendns.com text =

“flags 28 B 47E4 DPABBOHBBOBABOAB41""
-opendns.com text =

Yoriginid 23443359"
.opendns.com text

"orgid 162145Y
-op‘.-ll\:ll‘}-bul'l text

“Yactype A"
g.opendns.com text

“bundle 147229"

y.opend com text

For our purpose, the important information here is the OrgID and the Bundle. The OrgID is the identifier of
your organization's dashboard, and the Bundle is the identifier of the applied policy within that
organization.

Next, log in to your Umbrella dashboard and open a new tab or window in the browser. Then, plug the
two variables pulled from the debug output into the URL below:

https://dashboard.umbrella.com/o/<OrglD > /#/configuration/policy/<Bundle-ID >

This will take you directly to the policy that was applied to the computer (or user) the debug output was
run on, at the time it was run.
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Chromebook
Access the diagnostic page by browsing to http://localhost:8029/debug in a new tab.

The output should look similar to this:

000 & brensons X NewTab X\

C | [ flocalhost:8029/debug

[ localhost:8029/debug - Cisco Umbrella Chromebook client debug information
Q. localhost:8029/debug - Google Search

®  ® [ ciscoUmbrelia Chromebook - x

< C % Cisco Umbrella Chromebook client (Ext) | chrome-extension;//aekhbkcdcfgohgeafdpkjjibkhdlhnok/debug.htmi?os=cros&osVer... ¢

Cisco Umbrella Chromebook client

Debug Info. collected at: Mon Sep 03 2018 15:44:15 GMT+0530 (India Standard Time)

QoS cros
OS Version 68.0.3440.106

Organization ID 2442562

User Email -t s
Local IP 10.103.10.124
Palicy Url https://dashboard.umbrella.com/c/2442562/#/configuration/policy/382835

For our purpose, the important information here is the "OrganizationID" and the "Policy Url". The
"OrganizationlID" is the identifier of your organization's dashboard, and the "Policy Url" is the identifier of
the applied policy within that organization.

Next, log in to your Umbrella dashboard and open a new tab or window in the browser. Then, navigate to
the "Policy Url" which will take you directly to the policy that was applied to the computer (or user) the
debug output was run on, at the time it was run.
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http://localhost:8029/debug

Gathering or clearing AD Connector Logs

A functional AD Connector is green. Grey, yellow, and red statuses usually reflect a problem.

9 Sites & Active Directory

Status Version

ADO1 9 .. AD Connector | installed: 4 days ago @ 1.1.11

ADO1

The Connector was once connected, but is not currently connected to any of the DCs available. For more
information, and steps to resolve, please visit: https://support.opendns.com/entries/57607634#connector-

once-not-now

The Connector was once connected but is not currently connected to any of the VAs available. For more
information, and steps to resolve, please visit: hitps://support.opendns.com/entries

/57607634#connector-no-va

For each AD Connector which cannot connect to a Domain Controller, or has an error/warning in the
Dashboard, you should provide the AD Connector Log so Umbrella support can examine the findings.

Logs

To obtain the logs manually, follow the steps below:

e Attach the file C:\Program Files (x86)\OpenDNS\OpenDNS Connector\v1.x.x\OpenDNSAuditClient.log
o Attach the latest couple .zip log files from C:\Program Files (x86)\OpenDNS\OpenDNS
Connector\v1.x.x\ to the support ticket (do not send more than 3 .zip files)
o If the files are over 20MB, split them into two responses or contact us for upload details.

If working with a fresh configuration which has never worked, or if asked to send new logs:
o Stop the OpenDNS AD Connector service,
e Delete the file "C:\Program Files (x86)\OpenDNS\OpenDNS Connector\v1.x.x\OpenDNSAuditClient.log".

o Start the service up again.
e Wait 5 minutes and reply with this file.

This allows the file to be fresh and only with the most recent startup attempt.
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CIDR Table

CIDR SUBNET
0 0.0.0.0
1 128.0.0.0
2 192.0.0.0
3 224.0.0.0
4 240.0.0.0
5 248.0.0.0
6 252.0.0.0
7 254.0.0.0
8 255.0.0.0
9 255.128.0.0
10 255.192.0.0
11 255.224.0.0
12 255.240.0.0
13 255.248.0.0
14 255.252.0.0
15 255.254.0.0
16 255.255.0.0
17 255.255.128.0
18 255.255.192.0
19 255.255.224.0
20 255.255.240.0
21 255.255.248.0
22 255.255.252.0
23 255.255.254.0
24 255.255.255.0
25 255.255.255.128
26 255.255.255.192
27 255.255.255.224
28 255.255.255.240
29 255.255.255.248
30 255.255.255.252
31 255.255.255.254
32 255.255.255.255
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